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Preface 
The Oracle|Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology 
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the 
latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation 
folder available on your network from which you can access the Oracle|Agile documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals 
in both the Agile Web Client and the Agile Java Client. If you need additional assistance or 
information, please contact support http://www.oracle.com/agile/support.html 
(http://www.oracle.com/agile/support.html) for assistance. 

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please 
have the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html
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Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  

http://www.oracle.com/education/chooser/selectcountry_new.html




 

Chapter 1 

Introduction 

This chapter includes the following: 

 About Agile Portlet Services ................................................................................................................................ 1 
 What’s New.......................................................................................................................................................... 3 
 IBM WebSphere Portal Server ............................................................................................................................ 3 
 Portlet Communication and Collaboration ........................................................................................................... 3 

 
 

About Agile Portlet Services 
A portal is a Web site that provides internal and external users with a single point of access to a 
company’s Web-based resources. The portal’s single sign-on provides access to any number of 
small applications, called portlets, that let users manage various types of information. Users can 
personalize their own portal pages, making the portal more efficient, usable, and highly tailored to 
meet their individual needs. 

A portal usually contains several portlets. Each portlet provides users access to specific content or 
actions. Agile provides several predefined portlets that can be integrated with a company’s portal. 
Agile Portlet Services expose commonly-used Agile PLM functionality through a company’s portal 
and allow users to quickly link to specific Agile product content. 

The following figure shows a simplified portal system, one that does not include load balancers, 
application server clusters, proxy Web servers, or LDAP servers. 

Simplified portal system 

Portal
Clients

Agile Application Server WebSphere Portal Server

HTTP(s)

Database Server

HTTP(s)
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Agile Portlet Services includes the following portlets: 

Agile Portlets 

Category  Port le t  Descr ipt ion 

Search Advanced Search Searches for Agile PLM objects by matching one or 
more field values. 

 Quick Search Searches for Agile PLM objects by specifying a single 
matching value. 

 Saved Search Displays results for a saved search. 

 Search Folder 
Browser 

Allows you to browse search folders and select a 
particular search to run. 

 Search Results Works in conjunction with Advanced Search, Quick 
Search, and Search Folder Browser portlets. When you 
click a search in search portlet, the results appear in the 
Search Results portlet. 

Content Attachment Files Shows a selected Attachments table for objects. 

 Business Object Shows an Agile PLM business object (such as an item 
or change) to view or modify its fields. 

Productivity My Notifications Shows the current user’s Agile PLM notifications. 

 My Things to Do Shows lists of things the current user needs to 
complete, including Action Items, Program Activities, 
Requests, and Workflow Routings. 

Utility Bookmarks Shows the current user’s Agile PLM bookmarks. 

 Clipboard Lets you collect Agile PLM objects to later perform 
actions on them. 

 Quick Links Lets you add links to other portal pages or to external 
Web pages. 

 Quick Navigation Lets you navigate to bookmarked or recently visited 
Agile PLM objects, or display the contents of the 
Clipboard. 

 Report Folder 
Browser 

Lets you generate a report from one of the Report 
folders. 

 Single Signon Allows you to enter a user ID and password to enable 
single signon between the portal and the Agile PLM 
server. 

 Upload File Adds a new file to the Agile PLM system. 

 User Profile Lets you view and edit your Agile PLM user profile 
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What’s New in Agile PLM 9.2.2.4 
Agile Portlet Services provides the following new features with Agile PLM 9.2.2.4: 

 Multiple Values Selection - The User can now filter available values based on string criteria. 

 Advanced Search Portlet - The User can now select multiple values to search on a single list field. 

 My Bookmarks and Quick Navigations Portlets - The User can now select the folder that the 
bookmark will be added. The User can create a new folder and delete bookmarks and folders. 

 My Things to Do Portlet - This portlet now has My Request. 

 My Notifications and Requests Portlet - This portlet is now named My Notifications. The Request 
portion was moved to the My Things to Do Portlet. 

 

IBM WebSphere Portal Server 
Agile Portlet Services are currently supported on IBM WebSphere Portal. 

For complete WebSphere Portal installation instructions, hardware and software requirements, and 
configuration and troubleshooting information, please see the IBM WebSphere Portal InfoCenter. 
Use any of the following methods to access the IBM WebSphere Portal InfoCenter: 

 here Portal installation program. Click the InfoCenter button available in the WebSp

 Go to the WebSphere Portal InfoCenter URL. 
 WebSphere Portal 6.01: http://publib.boulder.ibm.com/infocenter/wspshelp/index.jsp 

After WebSphere Portal is installed, click Start  All Pr ograms, select IBM WebSphere, select Portal 
Server and finally select Information Center. 

 
rks 

e search results, the object’s contents can appear in a Business Object 

Note 

 

Portlet Communication and Collaboration 
Agile portlets communicate with each other using portlet actions and portlet messages. The portlets
work together to share information with each other. For example, the Search Results portlet wo
with one of the Search portlets (such as the Quick Search portlet) to display a table of search 
results. If you click one of th
portlet on the same page. 

You can control whether Business Object portlet clears the portlet of its contents if the 
message received from another portlet (such as a Search portlet) is not supported. For 
more information, see Setting Agile Portlet Parameters. 
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Chapter 2 

Installing and Upgrading Agile Portlet Services 

This chapter includes the following: 

 Installation Sequence .......................................................................................................................................... 5 
 Installing IBM WebSphere Portal......................................................................................................................... 6 
 Installing Agile Portlet Services ........................................................................................................................... 8 
 Setting Agile Portlet Services Application Parameters ........................................................................................ 9 
 Setting Up the Agile Portlet Configurator............................................................................................................. 11 
 Configuring the JNLP MIME Type ....................................................................................................................... 13 
 Upgrading Agile Portlet Services to Agile PLM 9.2.2.5........................................................................................ 14 
 Using the XML Upgrade Tool .............................................................................................................................. 14 
 Updating Agile Portlet Services ........................................................................................................................... 15 
 Clearing the Agile SDK Cache............................................................................................................................. 15 
 Setting Agile Portlet Parameters.......................................................................................................................... 16 
 Creating Portal Pages.......................................................................................................................................... 22 
 Agile PLM Administration Settings Related to Portlets ........................................................................................ 25 

 
 

Installation Sequence 
These instructions assume you have purchased the required hardware and software, and installed 
IBM WebSphere Portal as well as Agile PLM 9.2.2.5 before beginning to install Agile Portlet 
Services. 

To install and configure Agile Portlet Services: 

1. Install Agile PLM 9.2.2.5 and all its server-side components (database, file server, LDAP 
server, and so on). Agile Portlet Services connect to the Agile Application Server and cannot 
work without it. 

For detailed instructions on how to install the Agile Application Server, see the separate Agile 
PLM installation guide. 

2. Install IBM WebSphere Portal on a separate server from the Agile Application Server. 

3. Install Agile Portlet Services (AgilePortletPack2.war) on the WebSphere Portal Server. 

4. Configure Agile Portlet Services application parameters. 

5. If you are not using an LDAP server to authenticate users, create portal users and user groups. 
Otherwise, configure the Portal Server to use an LDAP server for authentication. 

6. Set up the Agile Portlet Configurator on a Web server so that portlet administrators can launch 
it to configure portlets easily. 

7. Create separate portal pages that use the Agile portlets. Some Agile portlets require 
configuration before they can be used. 
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Note On a portal page, add the Agile Single Signon portlet. You can then 
personalize the portlet to log into the Agile PLM server, otherwise, you will not 
be able to use the Agile portlets. 

8. Configure each of the Agile portlets, especially those based on the Business Object portlet. For 
Business Object portlets, you can edit each portlet’s XML configuration or use the separate 
Agile Portlet Configurator application. 

Note The WebSphere Portal Server XML configuration interface can be used to 
transfer the configuration of one portal to another. This is useful when moving 
from a development environment to a production environment. For more 
information about the XML configuration interface, see Exporting and 
Importing Portal Configurations using the XML Configuration Interface (see 
"Exporting and Importing Portal Configurations using XML Configuration 
Interface" on page 45), as well as the IBM WebSphere Portal InfoCenter. 

 

Installing IBM WebSphere Portal 
Because WebSphere Portal ships with multiple software components and works with other 
database, Web server, and LDAP server products, there are many different installation scenarios. 
For complete installation instructions, please see the IBM WebSphere Portal InfoCenter. 

To install WebSphere Portal: 

Insert the WebSphere Portal Setup CD and follow the onscreen instructions. 

Important Do not install WebSphere Portal Server into a path with spaces (such as “d:\Program 
Files\WebSphere”). 

 

Installing WebSphere Application Server and IBM HTTP Server as a 
Windows Service 

If you are going to run WebSphere Application Server and IBM HTTP Server (if you are installing it) 
as a Windows service, you must install the product as a user with the following local policy rights: 

 Act as part of the operating system 

 Log on as a service 

The WebSphere Portal installer assigns these local policy rights to your account automatically, but 
you will need to log out and log in again before continuing the installation. 

Web Server Considerations 

You can install the Web server on the portal machine or on a separate machine. If you install the 
Web server on a remote server, you should also consider installing the WebSphere Application 
Server plug-in, which takes care of load balancing between remote Application Server instances in 
a clustered environment. The plug-in will also allow you to change the WebSphere Portal URI. 

For more information about WebSphere Application Server plug-in, see the IBM WebSphere Portal 
InfoCenter. 
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Launching and Verifying the WebSphere Portal 

The best way to verify that WebSphere Portal has been installed and is working properly is to 
launch your portal and sign in. 

To launch WebSphere Portal: 

1. Make sure the Web server and WebSphere Portal server are running. 

2. Open a browser and go to the WebSphere Portal URL: 
http://<hostname>:<port>/<baseURI>/<homepage> 

For example, if you accepted the default values during installation, enter the following URI: 

http://<hostname>:10038/wps/myportal 

The portal should load in the browser. 

3. Click Log In. Enter the administrative user ID and password. Click Log In. 

If you have trouble either loading the WebSphere Portal in the browser or logging in as the 
administrator, see the IBM WebSphere Portal InfoCenter for troubleshooting information. 

Configuring the WebSphere Portal for LDAP 

If you install an LDAP server to manage users for the Agile Application Server, you can also use it 
for authentication on the WebSphere Portal. The same LDAP users can then access both systems. 

If the portal server will be integrated with LDAP, install the software as a user that exists within the 
LDAP environment. Note the user ID and password so that you can install WebSphere Fix Packs 
when necessary. 

For more information about setting up LDAP for the WebSphere Portal, see the IBM WebSphere 
Portal InfoCenter. 

Creating Portal Users and User Groups 

On a production server, WebSphere Portal supports authentication using an LDAP accessible 
directory. Ordinarily, you would use the same LDAP server to maintain users for both the Agile 
Application Server and the WebSphere Portal, thereby simplifying authentication for both systems. 
If you install WebSphere Portal for the purposes of portlet development, an LDAP directory is not 
required. In such an installation scenario, the portal administrator must define the users and user 
groups that use Agile Portlet Services. On a development server, users and user groups are stored 
in the WebSphere Portal database. 

The portal administrator can use the Access Control List portlet to control the access rights that 
users and user groups have for all portal resources, such as pages, and portlets. You can assign 
different access rights to each user or user group for each type of resource. Users in a group inherit 
the access rights assigned to the group. 

For more information about WebSphere access control, see the IBM WebSphere Portal InfoCenter. 

To create a portal user: 

1. Select Administration, select Access, then select Users and Groups. 

2. Click the link for All Authenticated Portal Users. 
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3. Click New User. 
4. Enter values for User ID, Password, Confirm Password, First Name, and Last Name, which are all 

required fields. For Preferred Language, select English. Optionally, specify the user’s email 
address. Click OK. 

To create a user group: 

1. Select Administration > Access > Users and Groups. 

2. Click the Root link if it is not already selected. 

3. Click New Group. 

4. Type a name in the Group Name field, and then click Create Group. 

5. In the User Groups list, click the name of the group you just created. Click Add Member. 
6. Select users by checking the Select box to the left of the user name. Click OK. 

To assign access rights to users and user groups: 

Select Administration > Access > User and Group Permissions. See User and Group Permissions 
portlet help for detailed instructions on using the portlet. 

Note If you do not assign access rights to users, they will not be able to view Agile 
portlets and pages. Only the portal administrator will have rights to those 
resources. 

 

Installing Agile Portlet Services 
Based on the license key you used to install Agile PLM 9.2.2.5 and its service packs, Agile Portlet 
Services are automatically installed on the Agile Application Server. All Agile portlets are contained 
in one file, AgilePortletPack2.war. Once you install the file, you must use WebSphere Portal 
Administration to install the portlets on the portal. 

To install Agile Portlet Services on WebSphere Portal 6.01: 

1. Install Agile PLM 9.2.2.5. For installation instructions, refer to the separate Agile PLM 
installation guide. 

Agile Portlet Services files are installed into the agile_home\Portlet_51 folder on the Agile 
Application Server. 

2. On the Agile Application Server, open a browser window and go to the WebSphere Portal URL. 
The default URL is: http://hostname:10038/wps/myportal 

3. Click Log In. Enter the administrative user ID and password. Click Log In. 

4. Select Administration > Portlet Management > Web Modules > Install. 
5. Click the Browse button to select the AgilePortletPack2.war file located in the 

agile_home\Portlet_51\war folder on the Agile Application Server. 

6. Click Next. 
The page lists the Agile portlets that will be installed from the WAR file you selected. 

7. Click Install. 
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Setting Agile Portlet Services Application Parameters 
Agile Portlet Services has several application parameters that are crucial to the successful 
operation of all Agile portlets. If any one of the application parameters is configured incorrectly, it 
can cause the portlets to malfunction or fail to connect to the Agile PLM server. 

To set Agile Portlet Services application parameters on WebSphere Portal 6.0.1: 

1. After Agile portlets are installed, log into the WebSphere Portal as an administrative user. 

2. Select Administration, select Portlet Management, then select Applications. 

3. Search for “AgilePortlets 2.1”. 

4. Click the  Edit Portlet Application icon. 

5. Specify parameters shown in the table below. 
 The parameter values are read-only. To change a parameter value, do this: 
 Copy the parameter name, and paste it into a text editor (such as Notepad). 
 Click the  Delete Parameter icon to remove the parameter. Click OK to confirm. 
 Click OK to save changes. 
 Click the  Edit Portlet Application icon again. 
 Copy the parameter name from the text editor, and paste it into the New Parameter text box. 
 Enter the new value for this parameter in the New Value text box. 

 Click  to add the new parameter. 

6. When you are finished modifying parameters, click OK. 

 

Parameter  Descr ipt ion 

VaultSlotName This is the name of the Credential Vault slot. Agile's Single Signon 
Portlet creates a slot with this name in the Credential Vault 
automatically. The default slot name is AgilePLMSlot. 

Note: Generally, you should not modify the value for 
VaultSlotName. If you specify a different slot name, you will need to 
create all user credentials again. 

download.javaPlugin.url Enter the location of the Java plugin to use for client-side browsers. 
The Gantt Chart applet uses this URL to download Java Runtime 
Environment (JRE) version 1.4.2 if the client computer does not 
have the proper version installed. 
Default: http://java.sun.com/j2se/1.4.2/download.html

UnzipFilesOnUpload If you upload a ZIP file to the Agile File Management server, this 
parameter determines whether a checkbox option will appear in the 
portlet to allow you to unzip the file automatically. Enter true (the 
default) or false. 
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Parameter  Descr ipt ion 

portletConfiguratorURL Enter the URL for the Portlet Configurator JNLP file. This URL 
makes it possible to launch the Portlet Configurator applet from the 
Business Object portlet configuration page to configure Agile 
portlets. Otherwise, you can configure Agile portlets by editing the 
XML configuration file. 

Example:http://plm.company.com/configurator/configurator.jnlp 

portalAdministratorEmail Enter the email address of the portal administrator. This address is 
used to notify the portal administrator of any errors that occur with 
Agile portlets. 

createMultipleFileFoldersOn-
Upload 

If you upload files to the Agile File Management server, this 
parameter determines whether a checkbox option will appear in the 
portlet to allows you to add the files to one file folder or multiple file 
folders. Enter true (the default) or false. 

help.base.url Enter the base URL for the Web server location where Agile portlets 
access online help files. Each portlet can be configured to access a 
specific help file located relative to this base URL. 

Example:http://portalserver/PortletsHelp 

ppm.weekendDays Enter two comma-delimited integers that represent the days of the 
week that are considered weekends by the Agile Product Portfolio 
Management (PPM) solution. Weekend days are not counted when 
Agile PLM calculates start and end dates based on the number of 
business days estimated for a task. 

Here is the list of integers for the days of the week: 

0=Sunday 

1=Monday 

2=Tuesday 

3=Wednesday 

4=Thursday 

5=Friday 

6=Saturday 

Default: 0,6 
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Parameter  Descr ipt ion 

proxy.server.url Enter the URL used to connect to the Agile server. Enter the URL in 
this format: 

Format:<protocol>://<serverName>:<port>/<virtualPath> 

where 

 protocol is HTTP or HTTPS. 

 serverName is the name of the Agile PLM server 
computer, not the proxy server. 

 port is the port number used for the specified server. 
Default ports are: 

IBM WebSphere Application Server = 9080 

Oracle Application Server = 7777 

 virtualPath is the virtual path for your Agile server. 
The virtual path is specified when the Agile system is 
installed. By default, the virtual path is “Agile”. 

Examples: 
Oracle Application Server: http://plm.company.com:7777/Agile

server.timeout The Agile PLM server session timeout value. Do not confuse this 
with the portal session timeout. The Agile PLM server will timeout 
after a specified number of minutes. The portal administrator can 
use this parameter to align the session timeout from Agile portlets 
with that of the Agile PLM server. 

To specify a timeout value, enter a positive number in minutes. To 
use the same timeout setting as the application server, specify a 
negative value. To never timeout, enter zero (0). 

Default: 60 (minutes) 

 
 

Setting Application Parameters for Copies of Agile Portlets 

When you make a copy of a portlet, such as the Business Object portlet or Advanced Search 
portlet, WebSphere Portal Server also makes a copy of the portlet application, along with its 
application parameters. If you subsequently make a change to the portlet application parameters, 
you must make the same change to every copy of the portlet application. 

Note When you copy a portlet and consequently make a copy of the AgilePortlets application, 
you can rename the new application to identify the portlet it is associated with. 

 

Setting Up the Agile Portlet Configurator 
The Agile Portlet Configurator provides an easy-to-use graphical user interface for configuring the 
Business Object portlets, which has many configuration options. When you install Agile Portlet 
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Services, the Agile Portlet Configurator files are installed into the following folder: 

 only Agile Business Object and User Profile portlets. It cannot be used to configure other 

1. 
 your 

e for both IIS and Apache Web 
ervers, see “Configuring the JNLP MIME Type” below. 

 

 WebSphere Portal 6.0.1: agile_home\Portlet_51\configurator 

Before you can launch the Agile Portlet Configurator applet, you need to add the files to your Web 
server and perform some configuration steps. You can use the Agile Portlet Configurator to 
configure
portlets. 

To set up the Agile Portlet Configurator: 

Configure your Web server so that it handles JNLP files. This is necessary so that Java Web 
Start can successfully download the application classes from the network and install it on
computer. For instructions on setting the JNLP MIME typ
s

Web Server  Defau l t  docroot  d i rectory  

Internet Information Server (IIS) c:\InetPub\wwwroot 

IBM HTTP Server c:\IBMHttpServer\htdocs 

Apache Web Server c:\Apache\htdocs 

 

In the <docroot>\configurator folder, open the configurator.jnlp file, and change the codebase 
and href parameters in the jnlp tag to reference the co

2. 
rrect locations on your Web server. See 

or

the text in bold below. After you edit the file, save it. 
<?xml version="1.0" encoding="utf-8"?> 
< jnlp spec="1.0+" codebase="http://webserver/configurat " 

rver/configurator/configurator.jnlphref="http://webse "> 

tor</title> 

scription> 
tooltip">Agile Portlet 

tonpc64.gif"/>--> 
lowed/> 

on> 

missions/> 

ize="640m"/> 
"/> 

 

    <information> 
        Product CollaborationAgile Portlet Configura

        <vendor>Agile Software Corporation</vendor> 
        <description>Agile Portlet Configurator</de

        <description kind="
Configurator</description> 
        <!--<icon href="pho

        <offline-al

    </informati

    <security> 
        <all-per

    </security> 
    <resources> 
        <j2se version="1.3+" max-heap-s

        <jar href="configurator.jar

        <jar href="AgileAPI.jar"/>
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        <jar href="crimson.jar"/> 

="xalan.jar"/> 

/application-desc> 

3. n 
torURL application 

4.  Agile Portlet Configurator is working by opening a browser and typing the 

        <jar href="jaxp.jar"/> 
        <jar href

    </resources> 
    <application-desc main-class= 
    
"com.agile.ui.portal.portlets.bizObject.configure.PortletConfiguration
Applet"> 
       <

</jnlp> 

Set the portletConfiguratorURL parameter for Agile Portlet Services to the same URL you used i
the previous step. For instructions on how to change the portletConfigura
parameter, see Setting Agile Portlet Services Application Parameters. 

Test whether the
following URL: 

http://Web Server/configurator/configurator.jnlp 

The Portlet Configurator login dialog box appears. 

If the Portlet Configurator does not load successfully, make sure the URLs Note 
specified in the configurator.jnlp file and the portletConfiguratorURL parameter 
match one another and are correct. Also, make sure Java Runtime 
Environment (JRE) 1.4.2 or later is installed on the client machine. For mo
troubleshooting in

re 
formation about the Portlet Configurator, see 

Troubleshooting. 

5. rver URL, type the 
rameter (for example, 

To log in, enter a valid Agile PLM user name and password. For the Se
same URL used for the serverURL application pa
http://plm.company.com:7777/Agile). Click OK. 

The Portlet Configurator window appears. 

Configuring the JNLP MIME Type 

stall applications using Java Web Start, you must configure 

1. Services (IIS) Manager. 
rs. 

3. Select Web Sites > Default Web Site folder, right-click, and choose Properties from the shortcut 

rties dialog box appears. 

A JNLP file is an XML document that describes a Java application to be launched by Java Web 
Start. To successfully download and in
the JNLP MIME type for your server. 

To configure the JNLP MIME type on Windows: 

Choose Start > All Programs > Administrative Tools > Internet Information 
The Internet Information Services (IIS) Manager window appea

2. Expand the folder for Internet Information Services > servername.   

the 
menu. 

The Default Web Site Prope

4. Click the HTTP Headers tab. 
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5. 

g box appears. 

8. ppears in the Registered MIME Types box. Click OK to close the MIME 

ose the Default Web Site Properties dialog box. 

y of the Apache Web server. 

2. .types file: 

3. Restart the Apache Web server. 

Upgrading Agile Portlet Services to Agile PLM 9.2.2.5 

3. here Portal as an administrator and uninstall any existing Agile PLM 9.0 or 

5. e Portlet Services.For more details, see Setting Agile Portlet 

7. n update XML configuration 
files to the Agile PLM 9.2.2.5 format using the XML Upgrade Tool. 

Using the XML Upgrade Tool 
tlet 

he 
 You can also 

ices are installed, open a command prompt window. 

2. a

Click the MIME Types button. 

The MIME Types dialo

6. Click the New button. 

7. In the Extension field, type jnlp. In the MIME Type field, type application/x-java-jnlp-file. Click OK. 

The new file type a
Types dialog box. 

9. Click OK to cl

10. Restart IIS. 

To configure the MIME type on Solaris: 

1. Locate the mime.types file in the conf director

Add the following line to the mime
application/x-java-jnlp-file       JNLP 

 

To upgrade an existing installation of Agile Portlet Services to 9.2.2.5, follow these steps: 

1. Upgrade your Agile PLM application server and database to Agile PLM 9.2.2.5. 

2. (Optional) Upgrade from WebSphere Portal Express 5.022 to WebSphere Portal 6.0.1. 

Log into the WebSp
9.1 portlets. 

4. Install new Agile PLM 9.2.2.5 portlets. For instructions, see Installing Agile Portlet Services. 

Set application parameters for Agil
Services Application Parameters. 

6. Update Agile PLM portlet pages for your portal. 

If you configured the Business Object Portlet for your portal, you ca

 

The XML Upgrade Tool is a simple command-line Java utility for upgrading Business Object Por
XML configuration files from earlier versions to 9.2. The main difference in the Business Object 
Portlet configuration is that it now supports configurations for multiple classes. You can use t
XML Upgrade Tool to convert an old XML configuration file to the new format.
concatenate multiple XML configuration files together into one new XML file. 

To update an existing Business Object Portlet XML configuration file to Agile 9.2.2.5 format: 

1. On the computer where Agile Portlet Serv

Ch nge to the XML Upgrade Tool folder: 
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 WebSphere Portal 6.01: agile_home\Portlet_51\xmlupgradetool 

radeTool.jar;./jdom.jar 

y multiple files, the XML Upgrade 

ame of 

1.xml and bop2.xml into a new 

r;./jdom.jar 

py it into the Portlet 

Updating Agile Portlet Services 

here Portal, you do not need to reinstall them. Instead, follow these steps to 

1. here Portal URL. The default URL is 

3. Run the following command: 
java -classpath ./XMLUpg
com.agile.ui.portal.portlets.bizObject.configure.tools.XMLUpgradeTool 
file1 [ file2...filen] 

At least one input file argument is required. Files must use fully qualified paths, such as 
c:\temp\bop1.xml. Separate multiple files with spaces. If you specif
Tool combines them into one output file. 

The output file is created in the same directory where you ran the XML Upgrade Tool. The n
the output file is the concatentation of the input filenames plus “_<release version>.xml”.  

The following example shows how to combine two files named bop
output file named bop1.xml_bop2.xml_9222.xml. 
java -classpath ./XMLUpgradeTool.ja
com.agile.ui.portal.portlets.bizObject.configure.tools.XMLUpgradeTool 
c:\temp\bop1.xml c:\temp\bop2.xml 

After you create the new Agile 9.2.2.5 XML configuration file, you can co
Configurator to configure an Agile 9.2.2.5 Business Object Portlet. 

If you receive an updated Agile Portlet Services WAR file and you have already installed Agile 
portlets on the WebSp
update Agile portlets. 

To update the Agile Portlet Services WAR file on WebSphere Portal 6.0.1: 

Open a b wser window and go to the WebSpro
http://<hostname>:10038/wps/myportal. 

2. Click Log In. Enter the administrative user ID and password. Click Log In. 

3. Select Administration, select Portlet Management, then select Web Modules. 

4. Find AgilePortletPack2.war, and then click the  Update Web Module icon. 

5. Click the Browse button to select the updated AgilePortletPack2.war file. Click Next. 
The Manage Web Modules page lists the portlet6. s that will be updated from the WAR file you 

7. bSphere Portal and clear the Agile SDK cache on the 
portal server. See the next section. 

Clearing the Agile SDK Cache 

wnload the latest classes, which 
t to the updated Agile 9.2.2.5 server. 

selected. Click Finish to begin updating them. 

After installation is finished, stop the We

 

Whenever you update the Agile Portlet Services WAR file by installing a new version, you must 
clear the Agile SDK cache on the WebSphere Portal computer. When you delete the Agile SDK 
cache, it forces Agile portlets to use the network class loader to do
allow Agile portlets to connec
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To clear the Agile SDK cache: 

1. Stop the WebSphere Portal. 

2. mand Prompt window. 

eters 
Before placing Agile portlets on a page to define the layout of your portal, you should set the 

Open a Com

3. Change to the %temp% directory: 

cd %temp% 

4. Delete the Agile SDK cache subdirectory: 

del AgileSDK.cache 

5. You are prompted “Are you sure?” Enter Y for Yes. 

6. Restart the WebSphere Portal. 
 

Setting Agile Portlet Param

parameters for each portlet you intend to use. 

To modify portlet parameters for WebSphere Portal 6.0.1: 

 Select Administration, select Portlet Management, then select Portlets. 

1. Click the  Configure Portlet icon for an Agile portlet. The Manage Portlets page appears. 

rameter you want to change, click the 2. For the pa  Edit Parameter icon. 

3.  Val
4. Click OK. 

Note m the portal 

In the ue field, enter a new value. 

Several portlet parameters are designed to be modified only fro
page when the portlet is in Configure mode. To enter configure mode, go to the 
portal page and click the portlet’s  wrench icon. Other users can personalize 

 by clicking the  penc rtlet’s title bil icon in the pothe portlet ar. 

 

Parameter  Descr ipt ion Agi le  Port le ts  

clearPortletContentsIfMes the 
tents if a message 

Business  
Object 

If set to true, this parameter clears 
portlet of its con
received from another portlet (such as 
a Search portlet) is not supported. 

Default: false 

customTitle An optional custom title for the por
that appears in the portlet’s title bar. 

tlet All 
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disableTableStatusFlags 

utes 

iness  
Object 

Saved  
Search 

rch  
Results 

If set to true, the portlet disables 
status flag attributes such as Has 
Attachments and Has Action Items. 

Default: false (status flag attrib

Bus

Seaare enabled) 

help.relativePath  
 with 

e.url value to create the 

All The relative path of this portlet’s help
file. The relative path is combined
the help.bas
complete URL for the help file. 

help.url e help 
et. This URL overrides 
ed by the 

ameter 
 application 

The complete URL for an onlin
file for this portl
the URL specifi
help.relative.path portlet par
and the help.base.url
parameter. 

All 

mTTConfiguredViews a-delimited series of 

 Routings 

My Things  Specify the comm
selected views for the portlet. 

Default: 1,0,2 

0 = My Workflow

1 = My Action Items 

2 = My Activities 

To Do 

mTTPossibleViews a-delimited series of 

ow Routings 

My Things  Specify the comm
possible views for the portlet. 

Default: 1,0,2 

0 = My Workfl

1 = My Action Items 

2 = My Activities 

To Do 

notfConfiguredViews Specify the comma-delimited series of 
selected views for the portlet. 

Default: 0,1 

0 = My Notifications 

1 = My Requests 

My Notifications 
and Requests 

notfPossibleViews  of 

1 = My Requests 

ons  
uests 

Specify the comma-delimited series
possible views for the portlet. 

Default: 0,1 

0 = My Notifications 

My Notificati
and Req
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objectType The currently selected Agile object 
type used in the Advanced Search 
portlet. 

Not Supported. Use the portlet’s
Configure mode to configure it. 

 

d  Advance
Search 

pageid_Report_cstRptCfgEnabled r 

gure mode. A separate 
nabled parameter is 
 each portal page on 

en added. Possible 
se) 

Report  
Folder  
Browser 

Equivalent to the Enable Custome
External Reports checkbox in the 
portlet’s Confi
cstRptCfgE
provided for
which the Report Folder Browser 
portlet has be
values for the parameter are 0 (fal
and 1 (true). 

Default: 0 

pageid_Report_rootFolderId 

er 

n the 

r is 

e Report Folder Browser 
portlet has been added. 

The portlet’s Configure mode offers 
a much easier graphical user 
interface for selecting a report 
folder. 

Report  
Folder  
Browser 

Select a report folder by specifying its 
numeric ID. 

To find the ID number of a report 
folder, move the mouse over a fold
in the Report Folder Browser portlet. 
The ID number appears i
browser’s status bar. 

A separate rootFolderId paramete
provided for each portal page on 
which th
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portlet.messaging Defines how the portlet communicates 
with itself, the page, or other pages 
when you click an object link in the 
portlet. Specify one of the following 
values: 

Empty string ("") – This is equivalent 
to removing the portlet.messaging 
parameter from the portlet, which 
causes the default behavior to be 
used. If you click a link for an object 
supported by a Business Object 
portlet, the portlet sends a message to 
itself. For other objects not supported 
by the Business Object portlet and for 
all other portlets, the default behavior 
is for the portlet to send a message to 
the current page when you click an 
object link. 
"page" – The portlet sends a 
message to the current page. 

"none" – Object links in the portlet 
appear as normal text. When you click 
the text, the portlet does not send a 
message. 

An internal portal URL – If the 
portlet.messaging parameter is not an 
empty string, “page”, or “none”, the 
portlet assumes the value is a URL 
that has been mapped to another 
portal page. The portlet sends the 
object context to the portal page 
identified by the URL. The URL must 
be an internal portal page that uses 
WebSphere’s URL mapping. For more 
information on how to use URL 
mapping, see the IBM WebSphere 
Portal InfoCenter. 

Internal portal URLs are of the format: 

/wps/myportal/mypage 

where mypage is the mapped URL for 
the page. The internal portal URL is 
appended to the portal prefix 
(http://hostname:port). 

Important: The URL mapping must be 
all lower case. 

When you click an object link in the 
portlet, the context of the object is 
attached to the URL as a querystring 
parameter. 

Note: Changes to the 
portlet.messaging parameter do not 
take effect until you log out of the 
portal and log in again (to clear the 
cache). 

Attachment  
Files 

Business  
Object 

Bookmarks 

Clipboard 

My Notifications  
and Requests 

My Things  
To Do 

Saved  
Search 

Search  
Results 
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queryCriteria Defines the search criteria used for the 
Advanced Search portlet. 

Not Supported. Use the portlet’s 
Configure mode to configure it. 

Advanced  
Search 

quickLinksXml Defines the XML configuration for the 
Quick Links portlet. 

Not Supported. Use the portlet’s 
Configure mode to configure it. 

Quick  
Links 

quickSearchInfoText Sample query information to help 
users enter a value to search for in the 
Quick Search portlet. This sample 
query text appears when you click the 
Show Sample Queries link in the 
portlet. 

Quick  
Search 

ReportServerSettingKeys Aggregates the keys that have been 
set for all portal pages on which the 
Report Folder Browser has been 
added. 

Not Supported. Use the portlet’s 
Configure mode to configure it. 

Report  
Folder  
Browser 

savedSearchId The ID number of a saved search. The 
results of the search will appear in the 
Quick Navigation portlet. 

Not Supported. This parameter is 
obsolete and does not affect the 
Quick Navigation portlet. 

Quick  
Navigation 

scrollBarHeightLimit The height of portlet data. If portlet 
data exceeds the specified height, a 
vertical scroll bar appears. 

This parameter does not set the height 
of the portlet. To do that, you must edit 
the page layout. 

Quick  
Navigation 

Report  
Folder  
Browser 

Search  
Folder  
Browser 

scrollBarWidthLimit The width of portlet data. If portlet data 
exceeds the specified width, a 
horizontal scroll bar appears. 

This parameter does not set the width 
of the portlet. To do that, you must edit 
the page layout. 

Quick  
Navigation 

Search Folder 
Browser 

searchableAttributes The list of available attributes that can 
be used in search criteria. 

Not Supported. Use the portlet’s 
Configure mode to configure it. 

Advanced  
Search 
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searchConfigurationXML Defines the XML configuration for the 
Advanced Search portlet. 

Not Supported. Use the portlet’s 
Configure mode to configure it. 

Advanced  
Search 

Search_savedSearchId Select a saved search by specifying its 
numeric ID. 

To find the ID number for a saved 
search, move the mouse over a saved 
search in the Search Folder Browser 
portlet. The ID number appears in the 
browser’s status bar. 

The portlet’s Configure mode offers 
a much easier graphical user 
interface for selecting a saved 
search. 

Saved  
Search 

searchDisplayAttributes The list of available attributes that can 
be used in search results. 

Not Supported. Use the portlet’s 
Configure mode to configure it. 

Advanced  
Search 

simpleSearchInfoText A brief message that provides 
information about a Simple Search to 
help users of this portlet. 

Not Supported. Simple Search is no 
longer an option of the Advanced 
Search portlet. 

Advanced  
Search 

supportedSearchTypes Specify the Agile object types that can 
be searched for in the Advanced 
Search portlet. 

Not Supported. Use the portlet’s 
Configure mode to configure it. 

Advanced  
Search 

tableHeight The height of the table that appears in 
the portlet. If the table exceeds the 
specified height, a vertical scroll bar 
appears. 

To enable tableHeight and tableWidth 
parameters, both must be set to 
nonzero values. 

Default: 0 (disabled) 

This parameter does not set the height 
of the portlet. To do that, you must edit 
the page layout. 

Business  
Object 

Saved  
Search 

Search  
Results 
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tableWidth The width of the table that appears in 
the portlet. If the table exceeds the 
specified width, a horizontal scroll bar 
appears. 

To enable tableHeight and tableWidth 
parameters, both must be set to 
nonzero values. 

Default: 0 (disabled) 

This parameter does not set the width 
of the portlet. To do that, you must edit 
the page layout. 

Business  
Object 

Saved  
Search 

Search  
Results 

 
 

Creating Portal Pages 
Note Please consult the IBM WPS Help for the latest information. 

The WebSphere Portal has a hierarchical structure of nodes. Each node is an element in the portal 
navigation tree. There are three types of nodes: 

 page — Displays content in the form of portlets. 

 label — Container for other nodes. Labels are used to group nodes in navigation. 

 URL — An addressable resource, such as external Web pages or pages within the portal site. 

The topmost node in the portal navigation tree is the content root. After you install WebSphere 
Portal, the following nodes appear under the content root: 

 My Portal — a label containing portlets for general use. This is the default page displayed after 
login. 

 Administration — a label used containing pages with portlets used to administer the WebSphere 
Portal. 

 yout. Page Customizer — a label with child pages used to manage page content and la

 
 URLs. You can access the Organize Favorites page using the 

tal node. Administrators can use 
Administration My Portal

view a page, first select the place. Once the place is selected, you can click a page within the place. 

ct Portal User Interface, then select Manage Pages. 

 Page Properties — a page used to edit the properties of portal page. 

Organize Favorites — a page containing the Organize Favorites portlet, which lets portal users 
organize their favorite labels and
My Favorites list in the banner. 

Users without administrative privileges can access only the My Por
links in the banner to switch between  and . 

A page displays content, or portlet applications. Each page can contain one or more portlets. To 

To create an Agile label in My Portal: 

1. Select Administration, sele
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2. Click the My Portal label. 

rs. Click OK. 

ot from the list, then select My Portal, and finally select Agile. 

4. f the page and click OK. For example, type Programs to create a page showing 

5. rop

Note L 

3. Click New Label. 
4. Type Agile and click OK. 

5. The Properties page appea

To add a page to the Agile label: 

1. Select Administration, select Portal User Interface, then select Manage Pages. 

2. Select Content Ro
3. Click New Page. 

Type the name o
Agile programs. 

The P erties page appears. Click OK. 

Portal pages can be imported from a portal configuration file using IBM’s XM
Access tool. For more information, see Exporting and Importing Portal 
Configurations using the XML Configuration Interface (see "Exporting and 
Importing Portal Configurations using XML Configuration Interface" on page 
45). 

 

Editing the Layout of a Page 

t of portal pages, select and arrange portlets on a page, 

e columns and rows with portlets or 

ust select a logical group of portlets to display Agile 

 
d for your portal. The same connection is used for all Agile portlets on 

 

 a Content portlet, such as a copy of the Business Object portlet, to display data for a selected 

ortal User Interface, then select Manage Pages. 

WebSphere Portal lets you control the layou
and edit portlets that require configuration. 

Pages can contain columns, rows, and portlets. You can fill th
other columns and rows. You can also create nested pages. 

To create a page with Agile portlets, you m
content. A page you create might include: 

the Single Signon portlet, which connects a user to the Agile PLM server. Only one Single 
Signon portlet is neede
multiple pages. 

a Search portlet to locate Agile PLM content. Quick Search and Advanced Search are 
examples of Search portlets. 

object. 

To edit the layout of a portal page: 

1. Select Administration, select P
2. Select a portal page to edit. 

3. Click the  Edit Page Layout icon. 

Some of the options you can select on the page include: 

 Layout template: Select from several pre-configured page layouts. 

 Add portlets: Select portlets to add to the page. 
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verrides the pre-configured layout templates. For example, you can set the column 

t includes the Single 

Show layout tools: Shows advanced layout tools for creating and editing page containers. This
option o
width. 

The following figure shows an example of a two-column layout for a page tha
Signon, Quick Search, Search Results, and Item (Business Object) portlets. 

 

Administering Pages 

an click the 

 

The portal administrator can permit specified users to change the layout of a page. If you have 
authority to change a page, select Administration, then select Manage Pages to modify the layout. For 
each page, you c  Set Page Permission icon to specify the permissions that users have 

, see the “Managing 
M WebSphere Portal InfoCenter. 

Setting Resource Permissions 

sions for all 
he portal 

ortlet. 

ect Resource Permissions. 

to edit the page. 

For more detailed information about creating and modifying places and pages
Pages, Layout, and Content” topic in the IB

In addition to creating users and user groups, the portal administrator can specify permis
types of portal resources, including pages and individual portlets. This allows t
administrator to set the level of personalization for each page or each p

To access Resource Permissions for your portal, use one of these methods: 

 Choose Administration, select Access, then sel

 Click Assign permissions in the page banner. 
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 Click the Set Permission icon in the Manage Pages portlet. 

For more detailed information about setting resource permissions, see the “Authorization” topic in 

re one or more skins that define the style of the area surrounding individual portlets. To set 
the default theme and skin for the portal, select Administration > Portal User Interface > Themes and 

st them on a development system. After the 
themes and skins are fully developed and tested, you must update and redeploy the WebSphere 

r. 

r 
rver to interface with the portal properly. The administrator must 

perform the following tasks to ensure that Agile PLM users can launch the portal Web site from 

ailable choices are Java Client, Web Client, or Portal Client. The Preferred 
Portal URL user preference specifies which portal URL to go to if the user selected Portal Client as 

inistration, see the Agile PLM Administrator Guide. 

cations and then select Portals. 

L. 

ortal. 

al URL. 

bled list, select Yes. 

ur preferred Agile PLM client for email notifications: 

 > Users. 

 Settings. 

the IBM WebSphere Portal InfoCenter. 

Using Custom Themes and Skins 

Portal pages also have themes and skins, which are usually created by the Web designer of the 
portal. Themes control the look and feel of the portal, including colors and fonts. For each theme, 
there a

Skins. 

If you create custom themes or skins, you can te

Portal EAR file with the new themes and skins. 

For more information about custom themes and skins, see the IBM WebSphere Portal InfoCente

Agile PLM Administration Settings Related to Portlets 
After Agile Portlet Services are successfully installed and configured, the Agile PLM administrato
must configure the application se

email notifications they receive. 

The Preferred Client user preference specifies which Agile PLM client to launch from email 
notifications. The av

his preferred client. 

For more information about Agile PLM adm

To add a portal URL to the Agile PLM server: 

1. Log into the Agile Java Client as an administrator. 

2. Choose Admin. Select Server Settings, then select Lo

3. Click the New toolbar button to add a portal UR

4. In the Name field, type the name of the p

5. In the Portal field, type the port

6. In the Ena

7. Click OK. 

To configure the Agile PLM portal as yo

1. Log into the Agile Web Client. 

2. Choose Admin > User Settings
3. Choose Tools > My
4. Click User Profile. 
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5. Click the Preferences tab. 

ferred Portal URL list and select a portal. 

9. Click Save

Note 

6. Click Edit. 
7. Click the Preferred Client list and select Portal Client. 

8. Click the Pre
. 

If the Preferred Portal URL list reads “No Privilege,” make sure the Modify 
Users privilege for Agile PLM applies to the “users.Preferences.Preferred 
Portal URL” attribute. 
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Configuring Agile Portlets 

This chapter includes the following: 

 About Portlet Configuration.................................................................................................................................. 27 
 Portlet Modes....................................................................................................................................................... 28 
 Configuring the Advanced Search Portlet............................................................................................................ 28 
 Configuring a Quick Links Portlet ........................................................................................................................ 29 
 Configuring the Report Folder Browser Portlet.................................................................................................... 30 
 Using the Portlet Configurator ............................................................................................................................. 31 
 Messaging Between Portlets ............................................................................................................................... 43 
 Exporting and Importing Portal Configurations using XML Configuration Interface............................................. 45 
 Using Process Extensions from within Portlets ................................................................................................... 46 
 Creating Custom Help for Agile Portlets .............................................................................................................. 49 

 
 

About Portlet Configuration 
This section describes how to configure Agile portlets. For most portlets, configuration is simple and 
requires selecting just a few options. The Business Object and User Profile portlets, however, are 
more complicated and have many more options for content and layout. You can configure those 
portlets by editing the XML configuration or using the Portlet Configurator. 

Once an Agile portlet is placed on a page, it can be used by people connecting to the portal. 
However, the following Agile portlets must be configured before they can be used: 

 Advanced Search 

 Business Object 

 Quick Links 

 Saved Search 

 Search Folder Browser 

 User Profile 

To configure he paga portlet from t e layout: 

1. Select Administration, select Portal User Interface then select Manage Pages. 

2. Select a portal page that uses Agile portlets. 

3. Click the  Edit Page Layout icon. 

4. Select an Agile portlet, such as one based on the Business Object portlet, and click the  Edit 
Portlet icon. 
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To configure a portlet from a po tal page: r

1. Select a portal page. 

2. Click the Configure icon  (a wrench) for a portlet. 

 help window with information about the portlet. Although Agile Portlet Services 

  portlet. Portlets that support Edit mode have 
a 

 

Portlet Modes 
Each portlet has up to four possible display modes: 

 View — Shows the portlet’s normal user interface. 

Help — Shows a 
does not include online help, you can create your own custom online help for each Agile portlet. 

Edit — Shows a page that lets users personalize a
 pencil icon. 

ure a portlet. Portlets that  Configure — Shows a page that allows portal administrators to config
support Configure mode have a   wrench icon. 

 

Configuring the Advanced Search Portlet 
The Advanced Search portlet has a graphical user interface for specifying its configuration, but it is 

partly because it also requires that you are familiar with the 

1. 

more complex than other Agile portlets, 
Agile API query language. This section steps you through the somewhat t cky process of 
configuring an advanced search. 

ri

To configure the Advanced Search portlet: 

Select a portal page with the Advanced Search portlet, and click the  wrench icon to enter 
Configure mode. 

In the Select Class To Search list, select the class or subcla2. ss to search for. 

 a different set of search and display attributes can 
d 

4. tes to include in the search parameters, and then click 

If you select a base class (such as Items),
be configured for each class. If you select a class (such as Parts), a different set o search an
display attributes can be configured for each subclass. 

f 

3. In the Define Search For list, select a class. 

Select one or more attribu  to move 

5.  in the search results, and then click 

them into the Selected Attributes box. 

Select attributes to display  to move them into the 

6. To exclude inactive list values from searches, make sure the Exclude inactive values for List 

rch and Return to return to the portlet. 

Selected Attributes box. 

Attributes box is checked. 

7. Click Update to update the search, Save to save the sea
 

Page - 28 Agile Product Lifecycle Management 

 

 



 Chapter 3  
 
 

Configuring a Quick Links Portlet 
The Quick Links portlet lets y ortlet with links to portal s, 
including other Web applications. The portlet uses the XML Config configure the 

The XML configuration for a Quick Links portlet has the following ta

ou set up a p pages and external Web site
uration window to 

links. 

gs: 

Tags Descr ipt ion Example  

Product Collaboration Portlet header Product CollaborationExternal 
Quick Links</title> 

<links> Container for links. <links> 

<!--links go here--> 

</links> 

<link  
  name=name 
  openInNewWindow=boolea
n> 

Link tag. If you are referencing a portal 
URL, the openInNewWindow parameter 
should be set to false (the default). If you 
are referencing an external URL, the 
openInNewWindow parameter should 

NewWindow="false"> 

/link> 

 

<link name="ViewMyPrograms" 
openIn

<
 

<link name="Yahoo" be set to true. 

openInNewWindow="true"></l
ink> 

 

<label> Label or description of the link. <label>Yahoo</label> 

<href ww.agile.com</
href> 

> A Web location (URL) <href>http://w

Here ks to several portal URLs: 

<?xm

</title> 

e="UpdateActionItems"> 
iew My Action Items</label> 

 < lin
 <link
  <lab
  <href>/wps/myportal/createprogram</href> 

is an example of a Quick Links XML configuration file with lin

l version="1.0" encoding="UTF-8"?> 
<links> 

CollaborationProgram Quick Links... Product 
 <link name="ViewMyPrograms"> 
  <label>View My Programs</label> 
  <href>/wps/myportal/viewmyprograms</href> 
 </link> 
 <link name="UpdateTasks"> 
  <label>View My Tasks</label> 
  <href>/wps/myportal/updatemytasks</href> 
 </link> 
 <link nam
  <label>V
  <href>/wps/myportal/myactionitems</href> 
/ k> 

 name="CreateProgram"> 
el>View New Program Creation</label> 

 </link> 
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</links> 

N “updatemytasks,” ote In the previous example, “viewmyprograms,” 
“myactionitems,” and “createprogram” are names that have been 
internally to porta n how to use UR

mapped 
L mapping on your 

Pages
l URLs. For information o

portal, see Setting Up Quick Links to Portal  (on page 30) below. 

Here ation file, this time with links to several 
exter

s...</title> 

 

e="Google" openInNewWindow="true"> 

 

Setting Up Quick Lin

feature of WebSphere Portal Server that allows portal administrators to define simple, easy-to-
ionship on the 

ration, select 

is another ex
nal URLs: 

ample of a Quick Links XML configur

<?xml version="1.0" encoding="UTF-8"?> 
<links> 

ollaborationHandy Web Link Product C
 <link name="Agile" openInNewWindow="true"> 

label>   <label>Agile Software</
  <href>http://www.agile.com</href> 
 </link> 
 <link name="Yahoo" openInNewWindow="true"> 

   <label>Yahoo</label>
  <href>http://www.yahoo.com</href>
 </link> 
 <link nam
  <label>Google</label> 
  <href>http://www.google.com</href>
 </link> 
 <link name="CNN" openInNewWindow="true"> 
  <label>CNN</label> 
  <href>http://www.cnn.com</href> 
 </link> 
</links> 

ks to Portal Pages 

To set up Quick Links to portal pages, you must first create a URL mapping. URL mapping is a 

remember URLs and map them to portal pages. The URL mapping creates a relat
portal between a name and a portal page. To create a URL mapping, select Administ
Portal Settings, then select URL Mapping. 

Important The URL mapping must be all lower case. 

For more information on how to use URL mapping, see the IBM WebSphere Portal InfoCenter. 

ort folders. You 
er. Once you select a folder, the portlet allows 

users to navigate to any reports in that folder and any subfolders. 

To configure a let from a portal page: 

2. 

Configuring the Report Folder Browser Portlet 
The Report Folder Browser portlet lets you generate reports from one of the Rep
can configure the portlet to select a particular fold

Report Folder Browser port

1. Select a portal page that has the Report Folder Browser portlet. 

Click the Configure icon  (a wrench) for the Report Folder Browser portlet. 

t Tree. 3. Select a report folder from the Repor
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Note This folder becomes the topmost folder that users can navigate to when they 
personalize the portlet. 

4. To enable customer external reports to be launch
Customer External Reports box is checked. 

ed from the portlet, make sure the Enable 

ML Configuration 
uage for XML), you 

cated, use the 

5. Click Save to save the configuration. 

6. Click Return to return to the portal page. 
 

Using the Portlet Configurator 
For Business Object or User Profile portlets, when you configure the portlet an X
window appears. If you’re familiar with XML and XSL (extensible stylesheet lang
may find it easy to edit the XML directly. However, if the XML seems too compli
Portlet Configurator to modify the configuration. 

 

Note Configuration of the Business Object portlet should be done only by the portal 
administrator. Consequently, the portal administrator should set resource 
permissions so that ordinary users do not have permission to personalize the 

 Business Object portlet. For more information about resource permissions, see
Setting Resource Permissions (on page 24). 
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The Portlet Configurator is a Java application that lets you configure Business Object and User 
 options, so 

 Portlet Configuratior 

Administrator privileges, see your Agile PLM administrator. 

rtlet Configurator 

Web site, it us hnology to 
 Configurator from 

urator from the XML Configurator window of a Business 

To la let Configurator from a portlet: 

2. 

3. Click the 

Profile portlets using a graphical user interface. Other portlets have simple configuration
the Portlet Configurator is not needed for them. 

The Portlet Configurator connects to the Agile PLM server to read business object classes, 
attributes, tables and actions. After you specify general portlet properties, the content to use 
(attribute groups, tables, and actions), and the layout, you can copy the XML configuration data 
from the Portlet Configurator to the portlet’s XML Configuration window. 

Roles and Privileges Needed to Use Agile

The Agile Portlet Configurator requires read-access to metadata tables for all Agile PLM classes 
and subclasses to configure Business Object portlets. Therefore, you should have Administrator 
privileges to use it. If you do not have 

Launching the Agile Po

When you connect to the Agile Portlet Configurator es Java WebStart tec
deploy the application to your computer. After that, you can launch the Portlet
your computer’s desktop. 

You can also launch the Portlet Config
Object or User Profile portlet. 

unch the Port

1. Select Administration, select Portal User Interface, then select Manage Pages. 

Select a portal page that uses Agile portlets. 

 Edit Page Layout icon. 

sed on the Business Object portlet, and click the 4. Select an Agile portlet, such as one ba  Edit 
Portlet icon. 

Launch Configurator link. The 
et Con in dialog box appears. After you log in, the Portlet Configurator appears 

in its own 
 

Portlet Configurator Tool

The Portlet Configurator has the 

5. Instead of editing the XML configuration file for the portlet, click the 
Portl figurator log

window. 

bar 

following toolbar buttons: 

Button  Command 
Equiva lent  

Descr ipt ion 

File > New current configuration to create a new configuration. If the Clears any  previous configuration was not saved, you will be prompted to save it. 

 File > Open Opens an existing XML configuration file. 

 
File > Save Saves the current configuration to an XML file. 
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Button  Command 
Equiva lent  

Descr ipt ion 

 Clipboard. 
Edit > Copy XML Copies the XML from the current configuration to the user’s 

 > Paste XML Pastes XML from the Clipboard to the current configuration. If there is Edit 
a current configuration, you will be prompted to overwrite it. 

 
 

Portlet Configurator Tabs 

The Portlet Configurator has three tabs: 

 Classes – Lets you select the classes and subclasses for the portlet, as well as specify the 
portlet title 

 Configure – Lets you define the content and layout of the Business Object portlet. 

 XML

ator has a navigation pane on the left side of the window 
t  between the different panes. To switch to a different pane, just click the 

ation pane. 

Usi

If a Business 
configuration ver with a new configuration. Use the Copy and Paste buttons to edit 

1. rtal page. 

 icon 

 – Lets you view or edit the XML for the portlet configuration. 
 

Portlet Configurator Navigation 

The Configure tab of the Portlet Configur
tha  lets you quickly switch
pane you want in the navig
 

ng Portlet Configurator to Modify a Configuration 

Object portlet has already been configured, you may want to modify the existing 
rather starting o

the existing configuration in the Portlet Configurator. 

To modify an existing portlet configuration: 

Select a po

2. Click the Configure  (a wrench) for a Business Object or a User Profile portlet that has 
. The XML Configuration window appears. 

ured yet, the XML Configuration window is 

already been configured

Note If the portlet has not been config
empty. If the portlet has been configured, click Copy to copy the configuration to 

oard. the clipb

3. Click Launch Configurator to start the Portlet Configurator. 

4. OK. In the Login dialog box, enter your username, password, and Agile PLM server URL. Click 

5. Click  Paste. 

6. Click the Configure tab. 

tent and Layout of the portlet. 

8. Click 

7. Specify Con

 Copy. 
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Note Optionally, you can click  Save to save the portlet configuration to an XML 
file so that you can open it later. 

9. Switch to the portlet’s XML Configuration window. 

10. Click Paste. 

11. Click Save. 

Click Return to return to the portal page. 12. 

Usi

For ject portlet, you must specify the classes and subclasses supported by the 
portlet. You can also specify a title for the portlet. To set portlet classes and its title, click the Classes 
tab b selected). The following options appear: 

 ars within the skin of the portlet window. It should identify the 
appears within the portlet. 

 e PLM class used by the portlet. After you select a class, click Add to 
d Class Views list. 

rtlet supports the following Agile PLM classes: 

an

 Man

ses supported by your Agile PLM system depend on the 

 

ng the Classes Tab 

each Business Ob

(by default, the first ta

Portlet Title — The title that appe
type of business object that 

Object Class — The Agil
add it to the Define

The Business Object po

 Changes 

 File Folders 

 Items 

 M ufacturer Parts 

ufacturers 

 Programs 

 Reports 

 User Groups 

Additionally, the Portlet Configurator allows you to configure the Users class to support the 
User Profile portlet. 

Note The actual base clas
Agile PLM solutions your company has purchased. However, only the above 
classes have been certified to be used with Agile portlets. 

 Available Subclasses – Based on the selected object class, this list shows the available 
subclasses that can be selected. 

classes are 
ting it. 

 the portlet configuration. 

 Selected Subclasses – Subclasses selected for this portlet. By default, all sub
selected. However, you can disable a subclass for the portlet by deselec

 Defined Class Views – Lists the object classes that have been added to
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Using the Configure Tab 

rtlet for a particular base 
ss. Before you can ss in the Configure for 

The Configure tab is where you specify the content and layout of the po
specify the content and layout, you must select a clacla

Base Class list. 

 

There are three types of content you can specify for the portlet: 

 Attribute Groups — Sets how Page One, Page Two, and
within the portlet. 

 Page Three attributes are grouped 

 

ttr

Bus ject classes and subclasses can have many attributes visible on Page One, Page Two, 
rface you should assign the 

attri e  groups. The same attribute can appear in multiple groups, if you prefer. To 
set ib Attribute Groups in the navigation pane of the Portlet Configurator. The 
following  

 
 Disp – Check this box to display the attribute group name as a heading for 

 se G s 
. By

play the attributes. Select one 

 All Page Three 
 <Subclass> (includes all Page One, Page Two, and Page Three attributes for a particular 

subclass) 

 Available Attributes – Displays the list of available attributes based on the currently selected filter. 

Note Although the User Group > Assignment > Date Group Table attribute is listed in the 

 Tables — Sets which tables are used in the portlet, and the columns that appear in each table.

 Action Groups — Sets the action buttons that appear in the portlet. 
 

A ibute Groups 

iness ob
and Page Three. Therefore, to provide a more usable portlet inte

but s to meaningful
attr ute groups, click 

 options appear:

Attribute Group Name – Name of the group of attributes. 

lay Name as Heading 
that area of the portlet. 

Collap roup by Default – Check this box to collapse the attribute group and show only it
name  default, the group is fully expanded. 

 Number of Columns – Specifies the number of columns used to dis
or two. 

 Filter – Displays a subset of attributes. Available filters are: 
  All Page One

 All Page Two 

Available Attributes list, it is not supported by Agile portlets. 

 Selected Attributes – Select attribute to add to the attribute group. 

 Add button – Adds the new attribute group. 

 Update button – Updates the selected attribute group with the current settings. 
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 Delete (X) button) – Deletes the selected attribute group. 

The following figure shows an attribute group that has been defined for Page One attributes. 

 

r in 
s, click Tables in the navigation pane of the Portlet 

he list. 

fault, the 

 Selected Columns – Selects columns to add to the table configuration. Columns appear in the 

 

Tables 

Based on a portlet’s object class, there are several tables you can choose to display in the portlet. 
You can specify which tables should appear in the portlet and the columns or fields that appea
each table. To configure the content of table
Configurator. The following options appear: 

 Choose Table – Select a table from t

 Display Name – Name of the table. 

 Display Name as Heading – Check this box to display the table name as a heading for that area of 
the portlet. 

 Collapse by Default – Check this box to collapse the table and show only its name. By de
table is fully expanded. 

 Available Columns – Displays the list of available columns based for the selected table. 
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portlet in the orde

To change the 

r they are listed. 

Note order of columns, select a column and click  or  to move 
it up or down. 

 Add button – Adds the new table configuration. 

 Update button – Updates the selected table configuration with the current settings. 

n configured. 

 Delete (X) button) – Deletes the selected table configuration. 

The following figure shows how the Change Orders.Affected Items table has bee

 

ith buttons and 
menu commands for object-level actions. These actions apply to the entire object. You can select 

nclude: 

tatus, and Reject) 

 

Action Groups 

When you configure a Business Object portlet, you can enable an Actions toolbar w

which actions are available in the portlet and organize them into functional groups. 

The actions that you can select for the portlet depend on the object class. They can i

 Common actions (Bookmark, Delete, New, Print, SaveAs, Send, Subscribe, Edit, 
CopyToClipboard) 

 Workflow actions (Approve, Audit Release, Audit Status, Comment, Change S
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 File Folder actions (Check In, Check Out, Cancel CheckOut, and Download) 

oups. 

 d

 
 s how many actions to display as buttons. If you 

 group. If you select 
s 

 Available Actions – Displays the list of available actions for the objec ss. 

 rtlet in the order 
they are l

 a column and click 

 Class-specific actions (such as Incorporate and Unincorporate for Items) 

 Process extensions 

Many of these actions can be grouped together. Two of them, Change Status and New, can only 
exist in their own action gr

To efine action groups, click Action Groups in the navigation pane of the Portlet Configurator. The 
following options appear: 

Action Group – Enter the name of the action group. 

to Display as Buttons – SpecifieNumber of Actions 
select 0, all actions will appear in a menu with the same name as the action
a number greater than 0 but less than the number of actions in the group, the additional action
will be listed in a menu with the name “More.” 

t cla

Selected Actions – Select actions to add to the group. Actions appear in the po
isted. 

Note To change the order of actions, select  or  to move it 
up or down. 

 e original Agile 
ses. 

st. For more 
n Portlets

Rename – Renames the selected action. If you change the name of an action, th
name appears to the right of it in parenthe

 New Action – Adds a new process extension action to the Available Actions li
information, see Using Process Extensions from withi  (on page 46). 

 Add button – Adds the new actions group. 

 Update button – Updates the selected action group with the current settings. 

 Delete (X) button) – Deletes the selected action group. 
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The following figure shows an actions group that has been defined for Workflow Actions. 

 

The following figure shows how the Actions toolbar looks in the portlet. Notice that New Object, 
Change Status, and Common Actions display as drop-down menus, and Workflow Actions only 
shows two buttons because the Number Of Actions to Deploy As Buttons option has been set to 2. The 
remaining actions in the Workflow Actions group, Audit Release, Audit Status, and Comment, 
appear on the More drop-down menu. 

 
 

Adding the Edit Action to an Actions Group 

The Edit action is important because it allows users to edit an object that appears in the Business 
Object portlet. If you do not add the Edit action to any Actions Groups, the Business Object portlet 
will be read-only for all users. 

Even if the Edit action has been added to Business Object portlet, it may be read-only for some 
users. Agile PLM privileges determine whether a user has rights to modify an object. If you do not 
have the Modify privilege for a particular object, the Edit action is disabled. 
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Adding the Change Status Action to an Actions Group 

The Change Status action for routable objects is a special action that behaves differently from other 
actions. If you add the Change Status action to an action group, it dynamically generates the list of 
status types from the object class and adds them to the Actions toolbar. However, the workflow 
status actions replace all other actions you may have selected for that actions group. 

If you choose to use the Change Status action, make sure it is the only action in the group. You can 
call the group Change Status. 

Adding the New Action to an Actions Group 

The New action allows you to create any of the objects that the portlet supports. The New action 
appears as a drop-down menu in the Business Object portlet. 

 

The New action cannot be grouped with other actions. It must be the single action added to a group. 
If you add the New action to a group with other actions, it will not appear in the portlet. 

Note The New action is not supported by User Profile portlet and Report objects. 
Consequently, you cannot use Agile portlets to create users or reports. 

When you create a new object within the Business Object portlet, the portlet usually displays a New 
Object dialog box with the fields needed to define the new object (such as the subclass and object 
number). 

 

If the portlet supports only one subclass and one autonumber sequence and an autonumber is 
required, the New Object dialog box does not appear and the object is created using the next 
autonumber. 

Portlet Layout 

After specifying the properties and content of a Business Object portlet, you can configure the 
portlet layout. To define the layout, click Layout in the navigation pane of the Portlet Configurator. 
The Layout window allows you to: 

 Construct a portlet header. 

Page - 40 Agile Product Lifecycle Management 

 

 



 Chapter 3  
 
 

 Select the layout template to be used. 

 Arrange the attribute groups and tables within the layout. 

The following options appear in the Layout window: 

 Display Object Status – Check this box to display the object’s status at the top right of the portlet. 
If the Actions toolbar is shown, the status appears below it. 

 Use Portlet Header – Check this box to display a custom header at the top left of the portlet. If the 
Actions toolbar is shown, the portlet header appears below it. 

 Construct Header – Use the list of attributes to the right to add Page One attributes to the header. 
In that way, you can display the object’s Number, Description, Status, or other Page One 
attributes in the header. You can also type attributes directly in the field, such as [Number]: 
[Description of Change]. 

 

fault layout for the Changes object class, 

 it to a form or tab. 

 f you chose the Form layout template, use the form to arrange attribute groups and 

 bbed layout template, use the different tabs to arrange attribute 

 d Layouts
it it. 

Note  groups always display first, followed by tables, in both the Form or 

 cted Page One attribute to the portlet header. Add – Adds the sele

Define Layout For – Select the object class for which you wish to define a layout. The Default 
layout applies to the object class and all its subclasses. You can also define layouts that are 
subclass-specific. For example, you can define a De
but define a separate layout for the ECO subclass. 

 Layout Template – Select either the Form or Tabbed layout template. 

 Available Attribute Groups – Select an attribute group and click > to add

 Available Tables – Select a table and click > to add it to a form or tab. 

Form – I
tables. 

 Tab Name – Type the name of a tab name to use, and click Add to add it to the Tabs box. 

Tabs – If you chose the Ta
groups and tables. 

 Add >> – Adds the configuration to the layout. 

 Update >> – Updates the configuration of the layout. 

Define  – Displays the layouts that have been defined for each object class. Select one 
to ed

Attribute
Tabbed layout. This is true even if you move a table above an attribute group in 
the list. 
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The following figure shows the configuration for a tabbed layout. 
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The following figure shows the configuration for a form layout. 

 
 

Messaging Between Portlets 
The portlet.messaging parameter of a portlet allows you to define how a portlet updates itself, the 
page, or other portal pages. Objects that are listed in Agile portlets—such as in a Search Results 
portlet—appear as standard links. When you click an object link, the portlet sends a message to its 
intended target. The target can be the same portlet, the page on which the portlet appears, or 
another page specified by its URL mapping. The context of the object that you’ve clicked is sent to 
the target, which causes it to be updated. 

When you modify a portlet’s portlet.messaging parameter, you can specify the following values: 

 an empty string ("") – uses the default portlet messaging. 

 page – updates the current page. 

 none – does not send a message to other portlets. In other words, object links in the portlet 
appear as normal text. 

 an internal portal URL – updates another page specified by URL mapping. The URL must be all 
lower case. 

Important Changes to the portlet.messaging parameter do not take effect until you log out of 
the portal and log in again (to clear the cache). 

If the portlet.messaging parameter is missing from a portlet or the parameter value is a null string, the 
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portlet uses the default portlet messaging behavior. For objects supported by the Business Object 
portlet, the portlet overrides the portlet.messaging parameter and always messages to itself. For 
objects that are not supported by the Business Object portlet, the default behavior is for the portlet 
to send a message to the page. 

If you want the Business Object portlet to message to other portlets on the same page when you 
click a link for a particular class of objects, make sure 

 the portlet.messaging parameter for the Business Object portlet is set to page 

 the Business Object portlet is NOT configured to support the class. If the Business Object 
portlet supports a class, it will always message to itself when you click a link for an object of 
that class. 

For more information on how to set portlet parameters, see Setting Agile Portlet Parameters. 

Clearing Portlets If Messaging Is Not Supported 

The clearPortletContentsIfMessageNotSupported parameter can be used to clear the contents of a 
portlet if a message received from another portlet (such as a Search portlet) is not supported. Use 
the clearPortletContentsIfMessageNotSupported parameter in conjunction with the portlet.messaging 
parameter to determine how portlets get updated when you click a link in them. 

For example, let us create a portal page with the following portlets: 

 Advanced Search 

 Search Results 

 Business Object Portlet - Changes (a copy of the Business Object portlet that supports only 
Changes) 

 Business Object Portlet - Items (a copy of the Business Object portlet that supports only Items) 

Specify the following portlet parameters: 

Port le t  Parameter  Va lue  

portlet.messaging page Search Results 

portlet.messaging page Business Object Portlet - 
Changes 

clearPortletContentsIfMessageNotSupported true  

portlet.messaging page Business Object Portlet - 
Items 

true clearPortletContentsIfMessageNotSupported  
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Exporting and Importing Portal Configurations using XML 
Configuration Interface 
Note Please consult the IBM WPS Help for the latest information. 

WebSphere Portal Server provides an XML configuration interface that allows you to configure the 
portal remotely. The XML configuration interface is a command line tool that connects to the server 
using an HTTP connection. You can use the tool to export the portal settings from a test server and 
import them to a production server. The command line client is located in the <wps_root>\bin folder. 
To invoke the client, use the xmlaccess.bat script. 

The syntax for the xmlaccess command is as follows: 
xmlaccess -in XML_file -user user -pwd password -url PortalConfigURL -out filename.xml 

Note You can specify the command options in any sequence. 

The xmlaccess command can be used to: 

 Transfer a complete portal configuration 

 Transfer a portal page 

 Transfer a portal page and its portlets 

 Create and modify resources 

 Perform administration tasks 

For more information about the WebSphere Portal Server XML configuration interface, see the IBM 
WebSphere InfoCenter. 

To export the WebSphere Portal Server configuration: 

1. In a command prompt window, go to the location of the XML Configuration Interface: 

cd <drive>:<wps_root>\ n bi

2. Run the following xmlaccess command to export the entire portal configuration to a file called 
Complete.xml: 

xmlaccess.bat -in ../doc/xml-samples/Export.xml -user wpsadmin -pwd wpsadmin  
-url http://hostname:10038/wps/config -out Complete.xml

You can use the resulting output file as the input parameter for the xmlaccess command to import 
the portal configuration on another portal server. 

To import the WebSphere Portal Server configuration on another server: 

1. Copy the latest AgilePortletPack2.war file to the <wps_root>\installableApps folder of the target 
server. 

2. In a command prompt window, go to the location of the XML Configuration Interface: 

cd <drive>:<wps_root>\bin 

3. Run the following xmlaccess command to import the portal configuration from the Complete.xml 
file that you previously exported: 
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xmlaccess.bat -in Complete.xml -user wpsadmin -pwd wpsadmin  
-url h /hostname:10038/wps/config -out Out.xmlttp:/

Note erver has a different portal administrator than the one used to If the target s
export the Complete.xml file, edit the file and change the user and pwd 
parameters. 

 

Using Process Extensions from within Portlets 
Agile PLM 9.2.2.5 includes a special web service that lets you invoke Agile PLM process extensions 
from tained in a file named PXWebService.jar, which is 
insta LM server: 

For more information about how to develop and deploy process extensions, see the Agile SDK 

1. e sure PXWebService is 

lled Agile PLM on a server named plmserver, you’re hosting Agile PLM 
sing a virtual path named “Agile,” 

 within a portlet. The web service is con
lled in the following folder on the Agile P

agile_home\integration\sdk\extensions 

Developer Guide. 

To configure your portal to use process extensions: 

Before using a process extension from within a portlet, check to mak
working. Open a browser and type the following URL: 

http://<server>:<port>/<virtualPath>/integration/ws/InvokePX?wsdl 

For example, if you insta
on Oracle Application Server using port 7777, and you’re u
type the following URL: 

http://plmserver:7777/Agile/integration/ws/InvokePX?wsdl

You should see a WSDL response in the browser. If you don’t, the web service may not have
been deployed properly.

 
 Make sure you installed the latest Agile PLM service packs. For more 

2. ly. 
e the same as the URL used to access the Agile Web Client, but without the 

3.  
the Web server used by your WebSphere Portal has Basic Authentication enabled. In 

Internet Information Server, you can enable Basic Authentication from the Directory Security 

ou can select the actions that appear 
at the top of the portlet. In addition to standard actions, like Bookmark, Delete, Print, and SaveAs, 

cess extensions. 

information about how to check whether Agile PLM web services are working, see the Agile 
PLM installation guide. 

Make sure that the proxy.server.url portlet application parameter has been configured correct
This should b
trailing “/PLMServlet”. For more information, see Setting Agile Portlet Services Application 
Parameters. 

Portlets use Basic Authentication to invoke the PXWebService on the Agile PLM server. Make
sure 

tab. 
 

Configuring a New Process Extension Action for a Portlet 

When you use the Portlet Configurator to configure a portlet, y

you can add custom actions that invoke pro

To configure a new process extension action: 

1. Configure a portlet based on the Business Object portlet. 
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2. In the XML Configurator window, click the Copy button to copy the configuration to the 

3. en the Portlet Configurator window. 

4. , enter your username, password, and the Agile 
PL er URL. Click OK to log in. 

tle urator window appears. 

Clipboard. 

Click the Launch Configurator link to op

In the Portlet Configurator Login dialog box
M serv

The Por t Config

5. Click  Paste. 

6. Click the Configure tab. 

7. In the navigation pane, click Action Groups. 

8. Click the New Action button. 

9. In Action Name
10. In Pro

Note rocess extensions, not just the ones that 

the  field, type a name for the custom action. 

the cess Extension field, select a valid process extension. 

The Portlet Configurator displays all p
have been assigned to a particular class. Only process extensions that have 
been assigned to the class are valid. 

11. 
rent portlet to be refreshed 

ension updates the object that 
d the page, you ca

12. can 

Note ML, the process extension action looks like any other action but has the 

If you selected a URL-based process extension (one that links to another Web page or a Web-
based application), check the Refresh Parent box if you want the pa
after you close the process extension page. If the process ext
launche n use this option to refresh the portlet. 

You now include the custom action in any Action Group. 

In the X
ref-id "%common.invokePX". Do not modify the ID
action. 

 of this process extension 

 

Testing a Sample Process Extension within a Portlet 

The Agile SDK includes a sample process extension, SamplePXes.jar. To obtain the source code 
for SamplePXes.jar and other Agile SDK sample programs, download the Developer 
Documentation Installer from the Agile Documentation Web Site (http://docs.agile.com). Follow 
instructions in the Agile SDK Developer Guide t

the 
o build and deploy SamplePXes.jar in the 

 configure the “Set Description” 

To test th t

1. Build an  sample process extensions included with the Agile SDK. 

agile_home\integration\sdk\extensions folder. You also need to
process extension using the Agile Java Client. 

e Se  Description process extension from within a portlet: 

d deploy the
a. Download the Java SDK from http://java.sun.com/ and install it on your development 

machine. 
b. Set the system variable JAVA_HOME to point to the home directory of your J

installation. 
ava SDK 

c. Download the Ant build tool from http://ant.apache.org/ and install it on your 
development machine. 

d. Set the system variable ANT_HOME to point to the home directory of your Ant 
installation. 
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e. Open a command prompt window and go to the Process Extensions samples folder 
tegration\sdk\samples\px. 

t to the 
r, where all process extensions and web 

ents that invoke them. 

2. Ena

ct Process Extensions. 
alog box appears. 

samplepx.SetDescription. 

 
process extension. To use the roles 

rrent user, leave the field blank. 
imeout – Use the default value (60 seconds). 

3. Click 

4. Add sion to the Item class. 
Data Settings > Classes. 

d.  toolbar button. 
 “Set Description” process extension, and then click > to move it into the 

5. In th o tion and 
assign it

ss. 
ation to the 

c. 
urator Login dialog box, enter your username, password, and the 

URL. Click OK to log in. The Portlet Configurator window appears. 

located in agile_home\in
f. Type the following command to build the samples: 
%ANT_HOME%\bin\ant all 

Ant uses the build.xml file to build the SamplePXes.jar file and then deploy i
agile_home\integration\sdk\extensions folde
service extensions are automatically deployed for cli

ble the Set Description process extension. 
a. Log into Java Client as an administrator. 
b. Choose Settings, select Data Settings, then sele
c. Click the New toolbar button. The Add Process Extension di
d. For Type, select Internal Custom Action. 
e. For Internal Custom Action, select 
f. Enter values in the following fields: 
 Name – Enter “Set Description.” 
 Description – Enter “Sets the description of the object.” 

Initiate From – Select “Actions menu.” 
 Roles – Select one or more roles to use for the 

and privileges of the cu
 T
 Enabled – Select Yes. 
OK. 

 the Set Description process exten
a. In Java Client, choose Settings > 
b. Open the Items class. 
c. Click the Process Extensions tab. 

Click the Assign
e. Select the

selected list. 
f. Click OK. 
e P rtlet Configurator, add the Set Description process extension as a custom ac

 to the Item class. 
a. Edit a portal page that has an Item Portlet, that is, a Business Object portlet 

configured for the Items cla
b. In the XML Configurator window, click the Copy button to copy the configur

Clipboard. 
Click the Launch Configurator link to open the Portlet Configurator window. 

d. In the Portlet Config
Agile PL  server M

e. Click  Paste. 
f. Click the Configure tab. 
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g. In the navigation pane, click Action Groups. 
tions”. 

Name, type “Set Description.” 

k OK. 
6. Sele

Actions list. 
m Actions action group. 

h. In the Action Groups field, type “Custom Ac
i. Click the New Action button. 
j. For Action 
k. For Process Extension, select “Set Description.” 
l. Clic
ct the “Set Description” action, and then click the > button to move it into the Selected 

a. Click the dd buttA on to move “Set Description” into the Custo

b. Click  Copy. 
c. Switch to the XML Configuration window, and click Paste. 

 to the portlet page. 
7. Invo th y that the Item Description is now 

assi
rtlet. 

tem Portlet. 
c. Choose Custom Actions > Set Description. 

stomizable, static online help files are not provided with 
 own custom online help files. You can choose one of two 

online help scenarios for each Agile portlet: 

elativePath portlet parameter, which specifies the relative path to a help file. The help handler 
 help 

d. Click Save to save the configuration. 
e. Click Return to return
ke e Set Description process extension and verif
gned to a random value. 
a. Open a portal page that has the Item Po
b. Search for or select an item to display data in the I

You should see the new value in the Description field. 

Creating Custom Help for Agile Portlets 
Because Agile portlets are so flexible and cu
them. However, you can create your

Using Relative References to Help Files 

With this scenario, all Agile portlets share the same base URL for help files. To specify the base 
URL, enter the help.base.url application parameter. For each portlet, enter a value for the 
help.r
for Agile portlets combines the base URL and the relative URL to form the complete URL to the
file. 

For example, if the help.base.url value is http://webserver/portlethelp, the help.relativePath for the 
vancedSearch.html. The complete URL that is used to access 

the file is http://webserver/portlethelp/AdvancedSearch.html
Advanced Search portlet could be Ad

. 

 
eter. 

For example, it on a Web server 
named “porta

Using Absolute References to Help Files 

With this scenario, each portlet specifies its own help file. You can use the help.url portlet parameter
to override the help.base.url application parameter and the help.relative.path portlet param

if you created help for the Advanced Search portlet and deployed 
l”, the help.url value could be http://portal/docfiles/AdvancedSearch.html. 
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Note If there is a value in a portlet’s help.url parameter, it overrides the 
help.relativePath portlet parameter and the help.base.url application parameter. 

 

Agile provides HTML help files for Agile portlets. To download portlets help, open a Web browser 
etwork (OTN) Web site

Downloading Online Help Files for Agile Portlets 

and go to the Agile Documentation on the Oracle Technology N  
. 

online help files: 

4. 

5. Set the help.base.url application parameter for AgilePortlets 2.1 to the URL for the 

http://www.oracle.com/technology/documentation/agile.html

To configure Agile portlets to use the downloaded 

1. Download the help archive file for Agile portlets. 

2. Extract all files from the help archive file. 

3. Create a folder called AgilePortletHelp in your Web server's docroot directory. 

Copy the portlet help files to the AgilePortletHelp folder. 

AgilePortletHelp folder (for example, http://Web Server/AgilePortletHelp).
instructions, see Setting Agile Portlet Services Application Parameters. 

 For complete 

ere Portal 6.0.1, follow 

To c Portal 6.0.1: 

r AgilePortlets 2.1. For complete instructions, see 

 

Configuring Online Help for Portlets on WebSphere Portal 6.0.1 

If you want to create custom online help files for Agile portlets on WebSph
these instructions. 

onfigure Agile portlets to use a base help URL on WebSphere 

1. Set the help.base.url application parameter fo
Setting Agile Portlet Services Application Parameters. 

2. Click Portlet Management and select Portlets. 

3. Select an Agile portlet, and click the  Configure Portlet icon. 

For the help.relativePath parameter, click the 4.  Edit Parameter icon. 

e box, enter a URL that is relative to the help.base.url setting for Agile portlets. For 

lect other Agile portlets and configure their help.relativePath parameter in the same way. 

 help URL on WebSphere Portal 

portal administrator. 

ortlets. 

p.url parameter, click the 

5. In the Valu
example, the value could be an HTML filename. 

6. Click OK. 

7. Se

To configure an Agile portlet to override the base help URL and use its own
6.0.1: 

1. Log into the WebSphere Portal Server as a 

2. Click Administration. 

3. Click Portlet Management  and select P

4. For the hel  Edit Parameter icon. 

. In the Value box, enter a help URL. 

6. Click OK. 

5
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Chapter 4 

Using Agile Portlets 

This chapter includes the following: 

 Agile Portlet Features .......................................................................................................................................... 53
 Using Edit Mode to Personalize Agile Portlets .................................................................................................... 53 
 Filtering Data in Portlets ........................................................................

 

.............................................................. 54 
 Advanced Search Portlet ..................................................................................................................................... 55 

Atta .. 59 
 Boo
 Bus ............................................................................................. 60 
 Clipboard Portlet .................................................................................................................................................. 61 

........................................................................................................................ 62 

........................................................................................................................ 63 
 Quick Links Portlet............................................................................................................................................... 64 

 
 

............................................................................................................ 67 
 Saved Search Portlet........................................................................................................................................... 68 

................................................................................................................................. 70 
ignon ....................................................... ..................................................... 70 
File Po ....................................................... ..................................................... 71 

 User Profile Por .............................................................................................................................. 72 
Sending P  Portal Ad .............. 72 

 
 

Agile Portlet Features
Each Agile portlet is a small Web-bas  displays 
data in tabular format. For example, F table of 
search results after you click the Sear

If you click an object’s number link in  like a 
Business Object portlet. 

Many of the Agile portlets have comm  or view 
an object in the Agile Web Client. Sev such as 
Bookmark or Subscribe—for each obj

Click 

 chment Files Portlet.....................................................................................................................................
kmarks Portlet ............................................................................................................................................... 59 
iness Object Portlet ..........................................

 My Notifications Portlet ................
 My Things To Do Portlet ..............

 Quick Navigation Portlet ...................................................................................................................................... 64
 Quick Search Portlet............................................................................................................................................ 66
 Report Folder Browser Portlet .................

 Search Folder Browser Portlet............................................................................................................................. 69 
 Search Results Portlet ........
 Single S
 Upload 

Portlet ...............
rtlet ...................
tlet.................

................

................

 ortlet Errors to the ministrator.................................................................................

 
ed application that connects to the Agile server and
ind portlets like the Quick Search portlet display a 
ch button. 

an Agile portlet, you load data in other Agile portlets,

on controls that let you refresh data from the server
eral Agile portlets let you perform relevant actions—
ect listed in the portlet. 

  to re  an Ag

Using Edit Mode to Pe
You can personalize Agile portlets as onalize a 

fresh the data in ile portlet. 

rsonalize Agile Portlets 
 per your own personal preference. When you pers
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portlet, it affects th for you and not for others. 

The following Agile portlets can be personalized: 

Advanced

 Attachment Files 

 Business Object 

 My Notifications and Requests 

 Things

 Quick Links 

 Report Folder Browser 

ed Sea

 Search Folder Browser 

 Single Signon 

 User Profile 

Most portlets have a simple Edit mode siness 
Object and User Profile portlets both u n window for Edit mode, but they 

u  the Portlet C e portlets. The Quick Links 
 uses on L Configurati t at 
 XML, d mpt to person

e portlet only 

  Search 

 My  To Do 

 Sav rch 

 user interface to personalize the portlet. The Bu
se the XML Configuratio

also allow yo to launch onfigurator to personalize thos
portlet
editing

ly the XM
o not atte

on window for personalization. If you are not proficien
alize the Quick Links portlet. 

To use Edit mode to personalize an Agile portlet: 

1. Select a portal page. 

2. Click the  Edit icon (a pencil) for a portlet. 

3. 

e default configuration specified by 

4. 

5. 
 

Fil
er out data from tables: 

h 

 Search Results 

k Filter. To show all 

Edit the configuration. 

For some portlets, you can click Use Defaults to revert to th
the portal administrator. 

Click Save. 

Click Return to return to the portlet. 

tering Data in Portlets 
The following Agile portlets provide a filter bar that lets you filt

 My Things To Do 

 My Notifications and Requests 

 Saved Searc

To use the filter bar, select an attribute from the list, type a value, and then clic

Page - 54 Agile Product Lifecycle Management 

 

 



 Chapter 4  
 
 

rows in the table, click Show All. 

 
 

Ad ce
ortlet searches for all objects with fields that match the conditions of the 

 configured properly before it can be used on a page. The fields and 

ot work if there are more than ONE searchable TEXT attributes 

van d Search Portlet 
The Advanced Search p
search. The portlet must be
attributes that you can use in an advanced search depend on the class that the portlet is configured 
to search. After you specify the search conditions, click Search. 

Note Auto Complete will n
configured: This limitation seems to only be an Internet Explorer issue. Auto Complete for 
the FireFox browser works perfectly.  

 

Using Advanced Search 

a particular 
clas the Advanced Search portlet as a separate search condition. For 
each search condition, specify a value. 

The relational operator used for each search condition depends on the data type of its attribute, as 

The Advanced Search portlet can be personalized to search on multiple attributes for 
s. Each attribute appears in 

shown in the following table. 

Data Type Relat iona l  Notes  
Operator  

Text Contains or Like Specify a text value. When you type a word to search for, it’s 
searched using the Contains relational operator. That means 

case the Like operator is used. Agile supports 
wildcards: the asterisk (*) and the question mark (?). The 

asterisk finds matches with more than one character. For 

of the specified 

results because it matches too many rows in the database. 

the search finds all objects that contain the word in that field. 

You can also use wildcard characters (* and ?) in the search 
value, in which 
two 
question mark finds matches with any other single character. 
For example, ?at finds hat, cat, and fat, but not splat. The 

example, *at find cat, splat, and big hat. The asterisk by itself 
finds all objects class. 

s 

Note: If you use wildcards, try to make your search as narrow 
as possible. Otherwise, the search may not be able to return 

Date r Than or Equal Specify Greate
To, Less Than or op
Equal To, or Between 

starting and ending date values. The relational 
erator used in the search depends on the range of dates you 

specify. If you specify only the starting date, the search finds 
any date values that are greater than or equal to it. If you 
specify only the ending date, the search finds any date values 
that are less tha you specify both the starting 

arch finds any date values that fall 
e. 

n or equal to it. If 
and ending dates, the se
within the specified rang
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Data Type Relat iona l  Notes  
Operator  

List Equal To Select one or more list values. If you select multiple list value
the search constructs multiple search conditions in the 
background and connects them using the OR logical operato
For example, if you select “Production, Prototype” for th

s, 

r. 
e 

hase attribute (as shown above), the search returns 
se Lifecycle Phase is equal to “Production” or 

Lifecycle P
items who
“Prototype”. 

Money Equal To cify a numeric value to search, not a currency code. When 
h, money values are converted to the 

company’s corporate currency to determine if they match the 
value you specified. 

Spe
you run the searc

MultiList Contains Select one or more list values. The search finds any matches 
that contain any of the specified list values, not all of them. If 
you select multiple list values, the search constructs multiple 
search condition s them using 
the OR logical o ple, if you select “Equipment, 

search returns items whose Product Line(s) field contains 

s in the background and connect
perator. For exam

PDA” for the Product Line(s) attribute (as shown above), the 

“Equipment” or “PDA”. 

Numeric Equal To Specify a numeric value to search. 

UOM Equal To , if 
r “5.0”. 

Specify a numeric value, not a unit of measure. For example
the value you are searching for is “5.0 Gram”, type “5” o

The logical operator 
in the Advanced Sea

AND or example, 
rch 

s where 

[Title Block.Number] is Like P0017* AND 
ri

ifecycle is Equal To "Production" OR 

itle Block.Lifecycle rototype") AND 

tle Block.Product  

[Title Block.Product Line(s)] Contains "Leo") AND 

[Title Block.Rev Incorp Date] is Between 02/01/06 and 05/01/06 

When you finish specifying values to search for, click Search. 

To save your search so you can reuse it later, click 

 is used between multiple search conditions that you specify. F
screen, the following logic applies: 

Search for Item

[Title Block.Desc

([Title Block.L
ption] Contains BOARD AND 
 Phase] 

[T  Phase] is Equal To "P

([Ti Line(s)] Contains "Capricorn" OR

 Save Search. 

To clear search criteria and start a new search, click Clear. 

OR Searches 

To do an “or” search, type two words separated by a space. For example, “FUSE TRANSISTOR” 
will find all objects that contain either “FUSE” or “TRANSISTOR” in that field. 
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AND Searches 

To do an “and” search, type a second word prepended with a plus sign. For example, “INTEL 
+PENTIUM” will find all objects that contain both “INTEL” and “PENTIUM” in that field. 

Note Do not put a space between the plus sign and the second word. For example, 
“INTEL + PENTIUM” is not a valid search value. 

 

AND NOT Searches 

To do an “and not” search, type a second word prepended with a minus sign. For exampl
PENTIUM” will find all objects that contain “INTEL” but not “PENTIUM” in that field. 

Matching Exact Phrases 

To do an “exact match” search, type a word or phrase surrounded by quotes. For exampl
BALANCER” will find all objects that contain the exact phrase “LOAD BALANCER” phrase in t
field. 

You can’t combine “exact match” searches with “and” or “or” searches. For example, 

“LOAD BALANCER” +IBM 

e, “INTEL -

e, “LOAD 
hat 

dvanced Search Portlet 

The A  Search portlet has slightly more co de options than other Agile portlets. 
You can ify the search fields and output fields. 

To personalize the Advanced Search portlet: 

l pa arch portlet, and click the 

is not a valid search value. 

Personalizing the A

dvanced mplex Edit mo
select one of the defined searches, and spec

1. Select a porta ge with the Advanced Se  pencil icon to enter Edit 
ode. 

ect one of the

lds to se

m

2. Sel  defined searches. 

3. Select fie arch, and then click the  right arrow to move them into the Selected 
. 

. Select search output fields, and then click the 

Attributes box

4  right arrow to move them into the Selected 

cted Attributes lists, select it and then click the 

Attributes box. 

5. To remove a field from either of the Sele  left 

 

arrow. 

6. Click Update to update the search. 

7. Click Return to return to the portlet. 

Edit Mode Options 

Opt ion  Descr ipt ion 

Select Search Select one of the predefined searches. 

 Page - 57

  

 



Portlet Services Installation and Configuration Guide  
 
 
 

Opt ion  Descr ipt ion 

Select Fields to Search Select search attributes by moving them into the Selected Attributes list. 

Select Search Output Select attributes that appear in the search result
Fields 

s. Move attributes from the 
Available Attributes list to the Selected Attributes list. You can also sort 

hem up or down in the Selected Attributes list. attributes by moving t

Update Saves the configuration. 

Return Returns to the page without saving. To save the configuration, make sure you 
click Update first. 

Use Default 
Configuration 

Uses the default search criteria. 

 
 

Configure Mode Options 

Opt ion  Descr ipt ion 

Select Class to Search Select the class used to search for objects. 

Define Search For Select the class you are defining search criteria for. 

Select the Attributes to Select attributes that users can use to search. Move attributes from the 
Available Attributes list to the Selected Attributes list. You can also sort 
attributes by moving them up or down in the Selected Attributes list. 

Include as “Advanced” 
Search Parameters 

Select Attributes to 
Display in the Search 

Select attributes that appear in the search results. Move attributes from the 
Available Attributes list to the Selected Attributes list. You can also sort 
attributes by moving them up or down in the Selected Attributes list. Results 

Add or Update Creates or updates the search definition. 

Exclude Inactive Values 
for List Attributes 

To exclude any inactive list values from search results, make sure this box is 
checked. 

Save Saves the configuration. 

Return Returns to the page without saving. 
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Attachment Files Portlet 
Shows a selected object’s Attachments table. To use the Attachment Files portlet, you must first 

o find an object with an Attachments table, such as an item or 
ment Files portlet to open, download, add, checkout, cancel 

checkout or check-in a file, as well as click a file to view it in the Agile Viewer. 

use one of the Search portlets t
change. You can use the Attach

 

the portlet shows To display the attachments table, select values for the Site and Rev. By default, 
all sites and the Introductory revision. 

Edit Mode Options 
Opt ion  Descr ipt ion 

Available Attributes Lists available attributes for the table. 

Selected Attributes Lists attributes you selected. 

Save Saves the configuration. 

Return Returns to the page without saving. 

Use Defaults Uses the default configuration. 

 
 

Configure Mode Options 

. Configure mode has the same options as Edit mode, except it does not have the Use Defaults option
See Edit Mode Options (on page 57). When you save settings in Configure mode, they become the 
defa tting

Bookmarks Portlet 
arks. You can define new Agile PLM bookmarks from 

ult se s for the portlet. 

Shows the current user’s Agile PLM bookm
Agile PLM clients, including the following Agile portlets: 

 Business Object 
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 Saved Search 

 Search Results 

 Obje
business objects (such as items or change orders). Easily the most 

owerful and most customizable of Agile’s portlets, the Business Object portlet allows you to create 
business objects. The Business Object portlet can 

bject classes. You can use the Portlet Configurator to customize 
ecting the presentation of data appropriate for your users. 

No r the Business Object Portlet, the figuration in the Configurator 

Agile Bookmarks are also listed in the Quick Navigation portlet. 

Business ct Portlet 
Shows data for Agile PLM 
p
portlets that display different types of Agile PLM 
be configured to support multiple o
the content and layout of the portlet, sel

te Fo PX menu Con
is assigned  or Subclasses.  to Base Classes, not Classes

The Business Object po ollowing Agile PLM classes: 

ile Folders 

s 

 Manufacturer Parts 

 

 support the User 

ct portlet to 
cts in the 

the portlet to backtrack 

rtlet supports the f

 Changes 

 F

 Item

Manufacturers 

 Programs 

 Reports 

 User Groups 

Additionally, the Portlet Configurator allows you to configure the Users class to
Profile portlet. 

Other portlets, such as the Search Results portlet, can message to the Business Obje
update its content when you click an object link. After you view a series of different obje
Business Object portlet, you can use the “breadcrumbs” feature at the top of 
to previously viewed objects. 

 

For information on how to use the Portlet Configurator to configure the Business Obje
Using the Portlet Configurator

ct portlet, see 
 (on page 31). 
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Note  "Transfer Authority","Change pproval Password" in the Using  Password" and "Change A
Busin
"Print

ess Objec e "Edit" and 
" actions a

Note in the Business Object Portlet, make sure 
odify privileges to the File Folder’s Title Block > Description field. 

t Portlet generates a "This portlet is unavailable" error. Th
re fine. 

 
you have M
To add a file attachment to an object displayed 

 

Clipboard Port
Lets you collect Agile PLM objects to later perform actions on them. 

let 

 

he Clipboard is a temporary storage portlet for the user’s current portal session. Each user can 
store different things in the Clipboard. You can manage the list of objects in the Clipboard to quickly 

 in, the Clipboard is empty. When you add objects to the 
ou empty the Clipboard, click Remove or Empty to remove them, 

or terminate the portal session. 

portlet to copy and paste objects to the Windows Clipboard. It is used only to copy and paste 

 more rows and then 

 > Paste action to 
oard may contain 

 

T

retrieve objects. When you first log
Clipboard, they remain there until y

Do not confuse the Clipboard portlet with the Windows Clipboard. You cannot use the Clipboard 

objects between Agile portlets. 

You can add objects to the Clipboard from other Agile portlets. Select one or
choose the Copy To Clipboard action. 

On any editable table in the Business Object portlet, you can use the Clipboard
paste the contents of the Agile Clipboard into the table. Although the Agile Clipb
disparate objects (such as Items and Changes), only objects supported by the table are pasted. 

Note You do not need to place the Clipboard portlet on a portal page to take
advantage of the Clipboard functionality available in other Agile portlets. 
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My Notifications Portlet 
 the current use ns appear as separate views in the portlet 
gh the portal a  not display both). 

If you click a Subject lin portlet, the portlet displays a detail view of the 

The table actions available in the My Notifications portlet vary based on the view that is selected. 

Shows
(althou

r’s notifications. Notificatio
dministrator can choose to

k in the My Notifications 
notification. 

View Avai lable  Table  Act ions  

My Notifications l) Delete, XLS (Save Table to Exce

Delete My Notifications - Detail 

 
 

Configure Mode Options 
Opt ion  Descr ipt ion 

Available Views Lists available views for the portlet: 

My Notifications 

Selected Views Lists views you have selected. 

Save Saves the configuration. 

Return Returns to the page without saving. 
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My Things To Do Portlet 
Shows objects routed to the current user that he must act on. The My Things To Do portlet 

 one portlet (although 
date your 

consolidates Action Items, Workflow Routings, and Program Activities within
the portal administrator can choose to not display all three views). You can up
assignments by marking them complete or entering a completion percentage. 

 

 on the view that is selected. The table actions available in the My Things to Do portlet vary based

View Avai lable  Table  Act ions  

My Action Items Accept, Decline, Mark Complete, Edit, XLS (Save Table to Excel) 

My Workflow Routings XLS (Save Table to Excel) 

My Program Activities Edit, XLS (Save Table to Excel) 

My Requests Accept, XLS (Save Table to Excel) 

My Requests - Detail Delete, Reject 

 
 

Displaying Things To Do by Due Date 

You can display Action Items or Progra
Due In list and select All, 1 Week, 2 W

m Activities based on the date they are due. Click the Display 
eeks, 1 Month, 2 Months, or 6 Months. 

Configure Mode Options 
Opt ion  Descr ipt ion 

Available Views Lists available views for the portlet: 
 My Action Items 
 My Workflow Routings 
 My Activities 
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Opt ion  Descr ipt ion 

Selected Views Lists views you have selected. 

Save Saves the configuration. 

Retu Returns to the page without saving. rn 

 
 

ou 
can displ

Quick Links Portlet 
Lets y add links to other portal pages or to external Web pages. When you click a link, the page 

ay within the portal or it can open within a new browser window. 

 

You can use the Quick Links portlet to provide users a quick way to navigate to a page for 
information on how to complete a task, or provide a link to another Web application. 

Edi det Mo  Options 
Opt ion  Descr ipt ion 

Copy Copies the XML configuration. 

Paste Pastes the XML configuration. 

XML Configuration D mation, see 
C

efines the XML configuration for the portlet. For more infor
onfiguring a Quick Links Portlet (on page 29). 

Save Saves the configuration. 

Return Returns to the page without saving. 

Use Defaults U n. ses the default configuratio

 
 

Configure Mode Options 

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option. 
When you save settings in Configure mode, they become the default settings for the portlet. See 
Edit Mode Options (on page 57) above. 

Quick Navigation Portlet 
Lets you navigate to bookmarked or recently visited Agile PLM objects, or objects that you copied to 
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the Clipboard portlet. 

 Recently Visited – During each Agile PLM session, the server maintains a list of the last 10 
objects viewed (or 25, 50, or 100, depending on the server’s Preference settings). 

cts to later return  Bookmarks – Agile PLM clients, including portlets, allow you to bookmark obje
to them quickly. 

Note The Bookmarks portlet also lists Agile PLM bookmarks. 

 Clipboard – Collects Agile PLM objects to later perform actions on them. You ca
Clipboard (not to be confused with the Windows Clipboard) to copy and pa
Agile portlets. 

If you click an object link in the Quick Navigation portlet, it automatically updates 
reference for portlets on the current page. Because the Quick Navigation po
portlet.messaging parameter, you cannot configure it to update the object referen
other pages 

n use the Agile 
ste objects between 

the object 
rtlet does not have a 

ce for portlets on 
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Quick Search Portlet 
Searches for Agile PLM objects by specifying a single matching value. 

 

t you 
ng of a word within 

pear in 

The Quick Search portlet lets you quickly locate objects in the Agile system that match the tex
enter. The text must be the start of the ID number you are seeking or the beginni
the object’s description. Quick Searches are not case sensitive. 

Select a class to search. Type the value to search for, and then click Search. The results ap
the Search Results portlet. 

Note For Quick Searches, the display fields that appear in the Search Results cannot be 
configured. 

To perform a full-text search of files listed on the Attachments tab of objects, make sure the Search 
Attachment Contents box is checked. 

Note Auto Compl ete will not work if there are more than ONE searchable TEXT attributes 
conf plete for 
the 

igured: This limitation seems to only be an Internet Explorer issue. Auto Com
FireFox browser works perfectly.  

 

Using Wildcards 

You can u card characters in your search. dcards: the asterisk (*) and the 
rk (?). T example, 

?at finds hat, cat, and fat, but not splat. The asterisk finds matches with more than one character. 
ample, *at find elf finds all objects of the specified 

e If you  search as narrow as possible. Otherwise, 

se wild Agile uses two wil
question ma he question mark finds matches with any other single character. For 

s cat, splat, and big hat. The asterisk by itsFor ex
class. 

Not use wildcards, try to make your
the search may not be able to return results because it matches too many rows 
in the database. 

 

Configure Mode Options 
Opt ion  Descr ipt ion 

Available Object 
Types 

Lists available object types for the Quick Search portlet. 

Selected Object 
Types 

Lists object types you selected. The order is important. The first object type 
listed is the default one used in the portlet. 
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Opt ion  Descr ipt ion 

Save Saves the configuration. 

Return Returns to the page without saving. 

 
 

Report Folder Browser Portlet 
Lets you generate reports from one of the Report folders. To generate a report, click a
listed reports to open the Report wizard. 

The Report Folder Browser portlet can be used on multiple portal pages, and yo
different settings for each page. This allows you to specify different root Repo
pages. 

ny of the 

u can configure 
rt folders on different 

 
 

Edit Mode Options 
Opt ion  Descr ipt ion 

Report Tree Displays a hierarchical list of report folders. Select one to use for the portlet. 

Save Saves the configuration. 

Return Returns to the page without saving. 

Use Defaults Uses the default configuration. 
 

Configure Mode Options 

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option. 
See Edit Mode Options (on page 57). When you save settings in Configure mode, they become the 
default settings for the portlet. 
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Important The Enable Customer External Rep
box. 

 

orts checkbox option is not supported. Do not check that 

Saved Search Portlet 
The Saved Search portlet displays results for a saved search. 

 

a page. The portal 
ng it for a 

ct portlet. You 
XLS (Save 

The Saved Search portlet must be configured properly before it can be used on 
administrator should make a copy of this portlet before adding it to a page and configuri
particular saved search. 

Click an object’s number to load its data in another portlet, such as a Business Obje
can also perform relevant actions for each object listed, such as Copy, Bookmark, and 
Table to Excel). 

Note The Saved Search portlet does not support parameterized searches, which 
prompt for search criteria when you run them. 

 

Configure Mode Options 
Opt ion  Descr ipt ion 

Search Tree Displays a hierarchical list of search folders and searches. Select a saved search 
to use for the portlet. 

Save Saves the configuration and returns to the page. 

Return Returns to the page without saving. 
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Search Folder Browser Portlet 
Allo u to ws yo browse search folders and select a particular search to run. 

 

rized 

rsonal Searches 
turn to go 

You can run any saved searches from the Search Folder Browser portlet, including paramete
searches, which prompt for search criteria when you run them. 

To remove searches from your Personal Searches folder, click the Organize Your Pe
link at the bottom of the portlet. Select a search, and then click Delete. After that, click Re
back to the normal portlet view. 

Note For searches that you run from the Search Folder Browser portlet, the display 
fields that appear in the Search Results are determined by how the sear
have been defined. 

ches 

 

Edit Mode Options 
Opt ion  Descr ipt ion 

Search Tree Displays a hierarchical list of search folders. Select a search folder from the tree to 
use for the portlet. 

Save Saves the configuration and returns to the page. 

Return Returns to the page without saving. 

Use Defaults Uses the default configuration. 

 
 

Configure Mode Options 

Configure mode has the same options as Edit mode, except it does not have the Use Defaults option. 
See Edit Mode Options (on page 57). In Configure mode, the Search Tree is used to select the 
base search folder for the portlet. 
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Search Results Portlet 
njunction with the Advanced Search, Quick Search, and Search Folder Browser portlet. 

When you ru rch in one of the search portlets, the results appear in the Search Results 
portlet. 

Works in co
n a sea

 

From the search results, you can click objects to display them in another portlet, such as the 
Busine ect portlet. You can also perform relevant actions for each object listed, such as Copy, 
Book d

Allows single signon between the portal and the Agile PLM server. 

ss Obj
mark, an  XLS (Save Table to Excel). 

Single Signon Portlet 

 

Configure the Single Signon portlet to specify the user ID and password used to connect to the 
Agile PLM system. This same connection can be used for every Agile portlets page on the portal. 
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If you use Edit mode to change the Agile PLM user ID and password, make sure y
log back into the portal. 

Note If you do not configure the Single Signon portlet co

ou log out and 

rrectly, other Agile portlets 
will not work. 

 

Edit Mode Options 
Opt ion  Descr ipt ion 

A e gil User ID The user’s unique ID for logging into the Agile PLM system. 

A e gil User Password The user’s login password. 

Save Saves the configuration. 

Cancel Cancels configuration changes. 
 

Upload File Portlet 
ch file to upload, or click Browse to Adds new files to the Agile PLM system. Specify the path of ea

select it. 
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Options 
Opt ion  Descr ipt ion 

Browse Select a file to upload. 

Upload Files to the 
Same File Folders 

To upload files to the same folder, check this box. Otherwise, a separate 
folder is created for each file. 

Unzip all Zip Fil
Add Them

es and 
 as Individual 

If the file is a Zip file (an archive format), check this box to unzip the file when 
you upload it. 

Files 

Type Select the File Folder type. 

Description Enter a brief description of the file. 

Upload File Creates a file folder containing the specified file. After the file is uploaded, 
click Done to return to the portlet. 

 

User Profile Portlet 
Lets you view and edit the Agile PLM user profile for the current logged in user. The User Profile
portlet is based on the Business Object

 
 portlet, but it is specifically for the User class. 

For information on how to use the Portlet Configurator to configure the User Profile portlet, see 
Using the Portlet Configurator (on page 31). 

Note If you change the password in the User Profile portlet, make sure you reset the 
password used in the Single Signon portlet as well. 

 

Sending Portlet Errors to the Portal Administrator 
If an error occurs with an Agile portlet,  the following message appears: 

If you see such a message, there should also be a link below it that reads Send Error To Portal 
 email client and send the contents of the error 

The system did not perform as expected. Please contact your Portal Administrator. 

Administrator. Click the link to open your default
message to the portal administrator. 

Note The portal administrator’s email address must be specified in the portalAdministratorEmail 
application parameter. For more information, see Setting Agile Portlet Services 
Application Parameters. 
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Troubleshooting 

ter includes the following: This chap

 Error Conditions................................................................................................................................................... 73
 Configuring Portlet Applications and Portlets ...................................................................................................... 75

Agile PLM Privileges...............................................................................................................................

 
 

 ............. 75 
 ............................................................................... 75 
 76 

 

 sure that the proxy.server.url parameter is correct and Agile PLM server is running. 

Properties

Searches...............................................................................
Business Object Portlet .......................................................................................................................................

 

Error Conditions 
I get an APIException.getRootCause message for all portlets 

When you try to display any portlet, an APIException.getRootCause message appears in the 
portlet. 

Solution: 

1. Make

2. Try to connect to http://plmserver.company.com:7777/Agile/ServerAPI . If you can’t 
connect, there is a problem with the Agile PLM server. HTTP ports may be configured 

LM server and the Oracle Application Server (OAS). For 
ings for OAS, see the Agile PLM Installation Guide. 

3. If you updated the Agile PLM server or updated the Agile SDK JAR files, make sure you clean 
 portal server. To clean up the cache, the portal administrator 

undle for base name com.agile.util.ejb.AGILE_JNDI 

When you try to display any portlet, a “Cannot find bundle for base name 

This is probably caused by a problem connecting from the portal to your application server. Make 

 You specified the fully qualified domain name of the application server when you installed Agile 
nd when you set portlet application parameters such as the proxy.server.url 

inconsistently between the Agile P
more details about HTTP port sett

up the Agile SDK cache on the
should stop the Portal Server and delete the AgileSDK.cache folder under c:\documents and 
settings\<user>\Local Settings\Temp. 

Cannot find b

com.agile.util.ejb.AGILE_JNDI” message appears in the portlet. 

Solution: 

sure 

 You can ping the application server. 

PLM 9.2.2.5 a
parameter. 

 HTTP ports are configured consistently on the application server. For details about HTTP port 
settings for Oracle Application Server, see the Agile PLM Installation Guide. 
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 You are trying to connect to an Agile PLM 9.2.2.5 application server and not a server from a 
different Agile release. 

 You have cleared the Agile SDK cache. If you updated the Agile Portlet Services WAR file on 
your portal server, your portal server may be using older class files and therefore cannot 
connect to the updated Agile PLM server. See Clearing the Agile SDK Cache (on pa

This object has been modified, please refresh and try again 

ge 15). 

d, 

t. 

el your changes. 

You were unable to save changes to an object due to an error. You clicked the error icon for a 
description of the error, and the following message box appeared: “This object has been modifie
please refresh and try again.” 

Solution: 

The object was modified by another user after you entered Edit mode, preventing you from saving 
your changes. To re-enter your changes, do the following: 

1. Click OK in the message box to close i

2. Click Cancel to exit Edit mode and canc

3. Click  Refresh to refresh the object with the latest data from the server. 

d a file attachment to an object in the Business Object portlet, an error appears: “Cell 

ject portlet, you may see this error if 
priate privileges for the File Folders class. The file attachment was added 

ld not be updated. 
olders class. 

Classes

efine a class view. After you click 
 list. 

configured 

4. Choose Actions > Edit to enter Edit mode. 

5. Re-enter your changes, and click Save. 

When I ad
[Title Block.Description] is read-only” 

When you add a file attachment to an object in the Business Ob
you do not have appro
successfully, but the Title Block > Description field of the associated File Folder cou
Make sure you have Modify privileges to the Title Block > Description field for the File F

Please select some BaseClasses first 

In the Portlet Configurator, I have selected an object class on the  tab, and then clicked the 
Configure tab. An error message appears: “Please select some BaseClasses first!” 

Solution: 

Although you selected an object class, you did not click Add to d
Add, the portlet title you entered appears in the Defined Class Views

This Portlet Instance has not been 

You tried to configure an Agile portlet in the page layout, and the following error appeared: “This 
Portlet Instance has not been configured. Please use the Configure or Edit Mode to set the required 
configuration parameters.” 

Solution: 

The portlet can only be configured from a portal page by using Configure or Edit mode. Do not try to 
configure the portlet from the page layout. 
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Configuring Portlet Applications and Portlets 
I cannot launch the Portlet Configurator 

When you try to launch the Portlet Configurator from the XML Configuration window for a portlet, 

 sure the proxy.server.url portlet application parameter is correct. 

 

the application doesn’t launch, or the configurator.jnlp file appears in your browser. 

Solution: 

1. Make

2. Make sure the portletConfiguratorURL portlet application parameter is correct. It should point to
the following URL: 

http://webserver:port/configurator/configurator.jnlp

3. Make sure you copied the agile_home\Portlet_51\configurator folder to your Web server’s 
docroot directory. On Internet Information Services (IIS), the default doc root is 
c:\Inetpub\wwroot. 

lient computer. 

figure a portlet and return to the page, the portlet takes up the entire page 

there 

Solution: 

Click the Restore icon in the portlet’s title bar to restore it to its proper size. 

M Privileges 
isplay “No Privilege” 

s to see those fields? 

force Field Level Read privilege, 
you may not be able to view the contents of specific fields. The words “No Privilege” appear in any 
field for which you do not have Read privileges. 

If you want to be able to view all fields, ask your Agile PLM administrator to change your user 
account so that the field-level Read privilege is not enforced. For more information, see the Agile 
PLM Administrator Guide. 

Searches 
There were too many records found in your search. Please narrow down your search. 

4. Make sure you configured the JNLP MIME type for your Web server. 

5. Make sure Java Runtime Environment (JRE) 1.4.2 or later is installed on the c

After I con

Sometimes after you configure a portlet, the portlet expands to fill the entire page even though 
are other portlets in the layout. 

Agile PL
Some fields d

When you view an Agile PLM object in a portlet, some fields display the value “No Privilege.” What 
does that mean? How can you get privilege

Solution: 

The Enforce Field Level Read privilege determines whether the Read privilege is enforced for Agile 
PLM fields. If you have been assigned a role that includes the En
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The wildcard search you ran matches too many rows in the database. When you run a search with 
a wildcard, the criteria must be matched against all words in the index, which can run into several 
million rows on a large database. Therefore, you should avoid creating wildcard searches that are 
too broad and that match too many rows in the database, for example, a search for “R*”. 

By default, Agile PLM returns up to 1000 search results for any search. The Agile PLM 
administrator can increase the maximum number of search results, but doing so could adversely 
affect system performance. 

A search that uses only an asterisk (*) for its criteria returns all records and is not subject to the 
maximum number of search results. 

Solution: 

If you see this error in the Search Results portlet, refine your search criteria and try again. Enter a 
more specific search string. For example, “Resistor*” is more specific than “R*”. 

Business Object Portlet 
All of my Business Object portlets are read-only 

You configured several different Business Object portlets, but they are all read-only. You can’t 
modify objects that appear in the portlets. How can you make Business Object portlets editable? 

Solution: 

When you configure the portlet, make sure the Edit action is included in one of the Action Groups. 
The XML configuration for Action Groups should look like this: 
<action-groups> 
  <action-group id="0" name="Custom Actions" groupMode="1" 
    collapseLimit="0" numberOfActionsToDisplayAsButtons="0"> 
    <action id="9" ref-id="%common.edit" name="Edit"/> 
  </action-group> 
</action-groups> 

If you prefer to make a Business Object portlet read-only for your portal, don’t include the Edit 
action in any of the portlet’s Action Groups. 

Of course, you can edit an object in Agile PLM only if you have the Modify privilege for that object. If 
you don’t have the Modify privilege, the Edit action is disabled. 

For more information, see Action Groups (on page 37). 

I cannot display the Gantt Chart 

From a Business Object portlet that displays program activities, you tried viewing the Gantt Chart by 
clicking the Gantt Chart action, but nothing happened, or you got the message “There is a problem 
logging into the Agile PLM Server. Please contact your administrator.” 

Solution: 

Make sure the proxy.server.url portlet application parameter is correct. See Setting Agile Portlet 
Services Application Parameters. 
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To check whether the Web client path is correct, open a browser and type the proxy.server.url value 
plus  
“/PLMServlet”. The Agile Web Client login screen should appear. 

I clicked the Assignment tab of a User Group, and the page displayed an error: “The system did not 
perform as expected.” 

You tried to display the Assignment tab of a User Group object in the Business Object portlet, but 
the page displayed an error. 

Solution: 

Log in as an portal administrator, and configure the Business Object portlet. Make sure the User 
Group > Assignment > Date Group Table attribute is not selected for any attribute groups. The Date 
Group Table attribute is not supported by Agile portlets. 

When I create a new Affected Item for a Change, the popup window doesn’t display all required 
fields 

You used the Business Object portlet to define a Change object, such as an ECO. On the Affected 
Items tab of the ECO, you clicked Create New to create a new part. However, the popup window 
that lets you create the part doesn’t display all of the required fields for that class. 

Solution: 

This is a known issue with the Business Object portlet. If you define Page Two or Page Three 
attributes to be required, they don’t appear in the popup window when you create a new part in the 
Affected Items tab of a Change. After you create the part, edit it to fill in the required fields. 

I configured the Business Object portlet to message to the page, but it is messaging to itself 

You set the portlet.messaging parameter for a Business Object portlet to “page”. However, when you 
click a part in the BOM table, the portlet updates itself instead of messaging to other portlets on the 
same page. 

Solution: 

For objects supported by the Business Object portlet, the portlet overrides the portlet.messaging 
parameter and always messages to itself. 

If you do not want the Business Object portlet to message to itself for a particular class, do not 
configure the portlet to support that class. However, the BOM table cannot message to the page 
because the table lists objects of the same class as the parent object, that is, other parts. Therefore, 
when you click a part on a BOM table, the portlet updates itself. 
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